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Lesson 1: Defining a Data Source View within an Analysis
Services Project
SQL Server 2008 R2
Designing a business intelligence application in SQL Server starts with creating an Analysis Services project in Business Intelligence Development Studio.
Within this project, you define all the elements of your solution, starting with a data source view.

This lesson contains the following tasks:

Creating an Analysis Services Project1

In this task, you create the Analysis Services Tutorial project, based on an Analysis Services template.

Defining a Data Source2

In this task, you define the AdventureWorks2008R2 DW database as the data source for the Analysis Services dimensions and cubes that you will
define in subsequent lessons.

Defining a Data Source View3

In this task, you define a single unified view of the metadata from selected tables in the AdventureWorks2008R2 DW database.

Modifying Default Table Names4

In this task, you modify table names in the data source view, so that the names of subsequent Analysis Services objects that you define will be
more user-friendly.
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Creating an Analysis Services Project
SQL Server 2008 R2
In the following task, you use Business Intelligence Development Studio to create a new Microsoft Analysis Services project named Analysis Services
Tutorial, based on the Analysis Services Project template. A project is a collection of related objects. Projects exist within a solution, which includes
one or more projects. For more information, see Defining an Analysis Services Project1.

To create a new Analysis Services project

1. Click Start, point to All Programs, point to Microsoft SQL Server 2008, and then click SQL Server Business Intelligence Development
Studio.

The Microsoft Visual Studio development environment opens.

2. On the File menu of Visual Studio, point to New, and then click Project.

3. In the New Project dialog box, select Business Intelligence Projects in the Project types pane, and then select Analysis Services Project in
the Templates pane.

Notice the default project name, the default solution name, and the default project location in the bottom of the dialog box. By default, a new
directory will be created for the solution.

4. Change the project name to Analysis Services Tutorial, which also changes the solution name, and then click OK.

You have successfully created the Analysis Services Tutorial project, based on the Analysis Services Project template, within a new solution that is
also named Analysis Services Tutorial.
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Defining a Data Source
SQL Server 2008 R2
After you create an Analysis Services project, you generally start working with the project by defining one or more data sources that the project will
use. When you define a data source, you are defining the connection string information that will be used to connect to the data source. For more
information, see Defining a Data Source Using the Data Source Wizard (Analysis Services)1.

In the following task, you define the AdventureWorksDW2008 sample database as the data source for the Analysis Services Tutorial project. While this
database is located on your local computer for the purposes of this tutorial, source databases are frequently hosted on one or more remote computers.

To define a new data source

1. In Solution Explorer, right-click Data Sources, and then click New Data Source.

2. On the Welcome to the Data Source Wizard page, click Next to open the Select how to define the connection page.

3. On the Select how to define the connection page, you can define a data source based on a new connection, based on an existing connection,
or based on a previously defined data source object. In this tutorial, you define a data source based on a new connection. Verify that Create a
data source based on an existing or new connection is selected and then click New.

4. In the Connection Manager dialog box, you define connection properties for the data source. In the Provider list, verify that Native OLE
DB\SQL Server Native Client 10.0 is selected.

Analysis Services also supports other providers, which are displayed in the Provider list.

5. In the Server name text box, type localhost.

To connect to a named instance on your local computer, type localhost\<instance name>. To connect to the specific computer instead of the
local computer, type the computer name or IP address.

6. Verify that Use Windows Authentication is selected. In the Select or enter a database name list, select AdventureWorksDW2008.

7. Click Test Connection to test the connection to the database.

8. Click OK, and then click Next.

9. On the Impersonation Information page of the wizard, you define the security credentials for Analysis Services to use to connect to the data
source. Impersonation affects the Windows account used to connect to the data source when Windows Authentication is selected. Analysis
Services does not support impersonation for processing OLAP objects. Select Use the service account, and then click Next.

10. On the Completing the Wizard page, type the name Adventure Works DW and then click Finish to create the new data source.

To modify the properties of the data source after it has been created, double-click the data source in the Data Sources folder to display the data
source properties in Data Source Designer.
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Defining a Data Source View
SQL Server 2008 R2
After you define the data sources that you will use in an Analysis Services project, the next step is generally to define a data source view for the
project. A data source view is a single, unified view of the metadata from the specified tables and views that the data source defines in the project.
Storing the metadata in the data source view enables you to work with the metadata during development without an open connection to any underlying
data source. For more information, see Designing Data Source Views (Analysis Services)1.

In the following task, you define a data source view that includes five tables from the Adventure Works DW data source.  

To define a new data source view

1. In Solution Explorer, right-click Data Source Views, and then click New Data Source View.

2. On the Welcome to the Data Source View Wizard page, click Next.

3. The Select a Data Source page appears. Under Relational data sources, the Adventure Works DW data source is selected. Click Next.

To create a data source view that is based on multiple data sources, you first define a data source view that is based on a single data source.
This data source is then called the primary data source. You can then add tables and views from a secondary data source. When designing
dimensions that contain attributes based on related tables in multiple data sources, you might have to define a Microsoft SQL Server data
source as the primary data source to use its distributed query engine capabilities.

4. On the Select Tables and Views page, you select tables and views from the list of objects that are available from the selected data source. You
can filter this list to help you in selecting tables and views.

Click the maximize button in the upper-right corner so that the window covers the full screen. This will make it easier to see the complete list of
available objects.

In the Available objects list, select the following objects. You can select multiple tables by clicking each while holding down the CTRL key:

DimCustomer (dbo)

DimDate (dbo)

DimGeography (dbo)

DimProduct (dbo)

FactInternetSales (dbo)

5. Click > to add the selected tables to the Included objects list.

6. Click Next.

7. In the Name field, type Adventure Works DW and then click Finish to define the Adventure Works DW data source view.

The Adventure Works DW data source view appears in the Data Source Views folder in Solution Explorer. The content of the data source view
is also displayed in Data Source View Designer in Business Intelligence Development Studio. This designer contains the following elements:

A Diagram pane in which the tables and their relationships are represented graphically.

A Tables pane in which the tables and their schema elements are displayed in a tree view.

A Diagram Organizer pane in which you can create subdiagrams so that you can view subsets of the data source view.

A toolbar that is specific to Data Source View Designer.

8. To maximize the Microsoft Visual Studio development environment, click the Maximize button.

9. To view the tables in the Diagram pane at 50 percent, click the Zoom icon on the Data Source View Designer toolbar. This will hide the column
details of each table.

10. To hide Solution Explorer, click the Auto Hide button, which is the pushpin icon on the title bar. To view Solution Explorer again, position your
pointer over the Solution Explorer tab along the right side of the development environment. To unhide Solution Explorer, click the Auto Hide button
again.

11. If the window is not hidden by default, click Auto Hide on the title bar of the Properties window.

You can now view all the tables and their relationships in the Diagram pane. Notice that there are three relationships between the
FactInternetSales table and the DimDate table. Each sale has three dates associated with the sale: an order date, a due date, and a ship date. To
view the details of any relationship, double-click the relationship arrow in the Diagram pane.
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Modifying Default Table Names
SQL Server 2008 R2
You can change the value of the FriendlyName property for objects in the data source view to increase the user-friendliness of their names. You can
also change the names of these objects after you define them.

In the following task, you will change the friendly name of each table in the Adventure Works DW data source view by removing the "Dim" and "Fact"
prefixes from these tables. This will increase the user-friendliness of the cube and dimension objects that you will define in the next lesson.

You can also change the friendly names of columns, define calculated columns, and join tables or views in the data source view to increase their
user-friendliness.

To modify the default name of a table

1. In the Tables pane of Data Source View Designer, right-click the FactInternetSales table, and then click Properties to display the properties
for the FactInternetSales object in the Adventure Works Tutorial data source view.

2. Click the Auto Hide button on the title bar of the Properties window so that this window will remain visible.

It is easier to change the properties for each table in the data source view when the Properties window remains open. If you do not pin the
window open by using the Auto Hide button, the window will close when you click a different object in the Diagram pane.

3. Change the FriendlyName property for the FactInternetSales object to InternetSales.

When you click away from the cell for the FriendlyName property, the change is applied. In the next lesson, you will define a measure group that
is based on this fact table. The name of the fact table will be InternetSales instead of FactInternetSales because of the change you made in this
lesson.

4. Click DimProduct in the Tables pane. In the Properties window, change the FriendlyName property to Product.

5. Change the FriendlyName property of each remaining table in the data source view in the same way, to remove the "Dim" prefix.

6. When you have finished, click the Auto Hide button to hide the Properties window again.

7. On the File menu, or on the toolbar of BI Development Studio, click Save All to save the changes you have made to this point in the Analysis
Services Tutorial project. You can stop the tutorial here if you want and resume it later.
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Lesson 2: Defining and Deploying a Cube
SQL Server 2008 R2
After you define a data source view in your Microsoft Analysis Services project, you are ready to define an initial Analysis Services cube.

You can define a cube and its dimensions in a single pass using the Cube Wizard. Alternatively, you can define one or more dimensions and then use the
Cube Wizard to define a cube that uses those dimensions. If you are designing a complex solution, you generally start by defining the dimensions. For
more information, see Designing Dimensions1 or Designing Cubes2.

A completed project through Lesson 1 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases3.

This lesson contains the following tasks:

Defining a Dimension4

In this task, you use the Dimension Wizard to define a dimension.

Defining a Cube5

In this task, you use the Cube Wizard to define an initial Analysis Services cube.

Adding Attributes to Dimensions6

In this task, you add attributes to the dimensions that you created.

Reviewing Cube and Dimension Properties7

In this task, you review the structure of the cube that you defined by using the Cube Wizard.

Deploying an Analysis Services Project8

In this task, you deploy the Analysis Services project to your local instance of Analysis Services, and learn about certain deployment properties.

Browsing the Cube9

In this task, you browse the cube and dimension data by using the browsers in Cube Designer and Dimension Designer.
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Defining a Dimension
SQL Server 2008 R2
In the following task, you will use the Dimension Wizard to build a Date dimension.

This lesson requires that you have either completed all the procedures in Lesson 1 or have opened the completed project for Lesson 1 that is
available by downloading and installing the updated samples. For more information, see Obtaining Updated Samples in Considerations for Installing SQL
Server Samples and Sample Databases1. When it is installed, the default location for this project file is C:\Program Files\Microsoft SQL
Server\100\Samples\Analysis Services\Tutorials\Lesson 1 Complete.

To define a dimension

1. In Solution Explorer, right-click Dimensions, and then click New Dimension.

2. On the Welcome to the Dimension Wizard page, click Next.

3. On the Select Creation Method page, verify that the Use an existing table option is selected, and then click Next.

4. On the Specify Source Information page, verify that the Adventure Works DW data source view is selected.

5. In the Main table list, select Date.

6. Click Next.

7. On the Select Dimension Attributes page, select the check boxes next to the following attributes:

Date Key

Full Date Alternate Key

English Month Name

Calendar Quarter

Calendar Year

Calendar Semester

8. Change the setting of the Full Date Alternate Key attribute's Attribute Type column from Regular to Date.To do this, click Regular in the
Attribute Type column. Then click the arrow to expand the options. Next, click Date > Calendar > Date. Click OK. Repeat these steps to change
the attribute type of the following attributes as follows:

English Month Name to Month

Calendar Quarter to Quarter

Calendar Year to Year

Calendar Semester to Half Year

9. Click Next.

10. On the Completing the Wizard page, in the Preview pane, you can see the Date dimension and its attributes.

11. Click Finish to complete the wizard.

In Solution Explorer, in the Analysis Services Tutorial project, the Date dimension appears in the Dimensions folder. In the center of the
development environment, Dimension Designer displays the Date dimension.

12. On the File menu, click Save All.
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Defining a Cube
SQL Server 2008 R2
The Cube Wizard helps you define the measure groups and dimensions for a cube. In the following task, you will use the Cube Wizard to build a cube.

To define a cube and its properties

1. In Solution Explorer, right-click Cubes, and then click New Cube.

2. On the Welcome to the Cube Wizard page, click Next.

3. On the Select Creation Method page, verify that the Use existing tables option is selected, and then click Next.

4. On the Select Measure Group Tables page, verify that the Adventure Works DW data source view is selected.

5. Click Suggest to have the cube wizard suggest tables to use to create measure groups.

The wizard examines the tables and suggests InternetSales as a measure group table. Measure group tables, also named fact tables, contain the
measures you are interested in such as the number of units sold.

6. Click Next.

7. On the Select Measures page, review the selected measures in the Internet Sales measure group, and then clear the check boxes for the
following measures:

Promotion Key

Currency Key

Sales Territory Key

Revision Number

By default, the wizard selects as measures all numeric columns in the fact table that are not linked to dimensions. However, these four columns are
not actual measures. The first three are key values that link the fact table with dimension tables that are not used in the initial version of this
cube.

8. Click Next.

9. On the Select Existing Dimensions page, select the Date dimension that you created earlier and then click Next.

10. On the Select New Dimensions page, select the new dimensions to be created. To do this, verify that the Customer, Geography and Product
check boxes are selected and clear the InternetSales check box.

11. Click Next.

12. On the Completing the Wizard page, change the name of the cube to Analysis Services Tutorial. In the Preview pane, you can see the
InternetSales measure group and its measures. You can also see the Date, Customer, and Product dimensions.

13. Click Finish to complete the wizard.

In Solution Explorer, in the Analysis Services Tutorial project, the Analysis Services Tutorial cube appears in the Cubes folder, and database
dimensions appear in the Dimensions folder. Additionally, in the center of the development environment, Cube Designer displays the Analysis
Services Tutorial cube.

14. On the toolbar of Cube Designer, change the Zoom level to 50 percent, so that you can more easily see the dimensions and fact tables in the
cube. Notice that the fact table is yellow and the dimension tables are blue.

15. On the File menu, click Save All.
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Adding Attributes to the Customer Dimension

Adding Attributes to the Product Dimension

Adding Attributes to Dimensions
SQL Server 2008 R2
In the following tasks, you will use Dimension Designer to add attributes to the Customer and Product dimensions.

To add attributes

1. Open Dimension Designer for the Customer dimension. To do this, double-click the Customer dimension in the Dimensions node of Solution
Explorer.

2. In the Attributes pane, notice the Customer Key and Geography Key attributes that were created by the Cube Wizard.

3. On the toolbar of the Dimension Structure tab, use the Zoom icon to view the tables in the Data Source View pane at 100 percent.

4. Drag the following columns from the Customer table in the Data Source View pane to the Attributes pane:

BirthDate

MaritalStatus

Gender

EmailAddress

YearlyIncome

TotalChildren

NumberChildrenAtHome

EnglishEducation

EnglishOccupation

HouseOwnerFlag

NumberCarsOwned

Phone

DateFirstPurchase

CommuteDistance

5. Drag the following columns from the Geography table in the Data Source View pane to the Attributes pane:

City

StateProvinceName

EnglishCountryRegionName

PostalCode

6. On the File menu, click Save All.

To add attributes

1. Open Dimension Designer for the Product dimension.

2. In the Attributes pane, notice the Product Key attribute that was created by the Cube Wizard.

3. On the toolbar of the Dimension Structure tab, use the Zoom icon to view the tables in the Data Source View pane at 100 percent.

4. Drag the following columns from the Products table in the Data Source View pane to the Attributes pane:

StandardCost

Color

SafetyStockLevel

ReorderPoint

ListPrice

Size

SizeRange

Weight

DaysToManufacture

ProductLine

DealerPrice

Class

Style

ModelName

StartDate
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EndDate

Status

5. On the File menu, click Save All.
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Reviewing Cube and Dimension Properties
SQL Server 2008 R2
After you have defined a cube, you can review the results by using Cube Designer. In the following task, you review the structure of the cube in the
Analysis Services Tutorial project. 

To review cube and dimension properties in Cube Designer

1. To open the Cube Designer, double-click the Analysis Services Tutorial cube in the Cubes node of Solution Explorer.

2. In the Measures pane of the Cube Structure tab in Cube Designer, expand the Internet Sales measure group to reveal the defined measures.

You can change the order by dragging the measures into the order that you want. The order you create will affect how certain client applications
order these measures. The measure group and each measure that it contains have properties that you can edit in the Properties window.

3. In the Dimensions pane of the Cube Structure tab in Cube Designer, review the cube dimensions that are in the Analysis Services Tutorial cube.

Notice that although only three dimensions were created at the database level, as displayed in Solution Explorer, there are five cube dimensions in
the Analysis Services Tutorial cube. The cube contains more dimensions than the database because the Date database dimension is used as the
basis for three separate date-related cube dimensions, based on different date-related facts in the fact table. These date-related dimensions are
also called role playing dimensions. The three date-related cube dimensions let users dimension the cube by three separate facts that are related
to each product sale: the product order date, the due date for fulfillment of the order, and the ship date for the order. By reusing a single
database dimension for multiple cube dimensions, Analysis Services simplifies dimension management, uses less disk space, and reduces overall
processing time.

4. In the Dimensions pane of the Cube Structure tab, expand Customer, and then click Edit Customer to open the dimension in Dimension
Designer.

Dimension Designer contains these tabs: Dimension Structure, Attribute Relationships, Translations, and Browser. Notice that the
Dimension Structure tab includes three panes: Attributes, Hierarchies, and Data Source View. The attributes that the Dimension contains
appear in the Attributes pane. For more information, see: Defining Dimension Attributes1, Creating User-Defined Hierarchies2, Defining Attribute
Relationships3

5. Switch to Cube Designer by right-clicking the Analysis Services Tutorial cube in the Cubes node in Solution Explorer and then clicking View
Designer.

6. In Cube Designer, click the Dimension Usage tab.

In this view of the Analysis Services Tutorial cube, you can see the cube dimensions that are used by the Internet Sales measure group. Also, you
can define the type of relationship between each dimension and each measure group in which it is used.

7. Click the Partitions tab.

The Cube Wizard defined a single partition for the cube, by using the multidimensional online analytical processing (MOLAP) storage mode without
aggregations. With MOLAP, all leaf-level data and all aggregations are stored within the cube for maximum performance. Aggregations are
precalculated summaries of data that improve query response time by having answers ready before questions are asked. You can define additional
partitions, storage settings, and writeback settings on the Partitions tab. For more information, see Partitions (Analysis Services -
Multidimensional Data)4, Aggregations and Aggregation Designs5, Designing Partition Storage and Aggregations6

8. Click the Browser tab.

Notice that the cube cannot be browsed because it has not yet been deployed to an instance of Analysis Services. At this point, the cube in the
Analysis Services Tutorial project is just a definition of a cube, which you can deploy to any instance of Analysis Services. When you deploy and
process a cube, you create the defined objects in an instance of Analysis Services, and populate the objects with data from the underlying data
sources.

9. In Solution Explorer, right-click Analysis Services Tutorial in the Cubes node and then click View Code.

The XML code for the Analysis Services Tutorial cube is displayed on the Analysis Services Tutorial.cube [XML] tab. This is the actual code that is
used to create the cube in an instance of Analysis Services during deployment. For more information, see: How to: View the XML for an Analysis
Services Project7

10. Close the XML code tab.

Deploying an Analysis Services Project8

Tasks
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Deploying an Analysis Services Project
SQL Server 2008 R2
To view the cube and dimension data for the objects in the Analysis Services Tutorial cube in the Analysis Services Tutorial project, you must deploy the
project to a specified instance of Analysis Services and then process the cube and its dimensions. Deploying an Analysis Services project creates the
defined objects in an instance of Analysis Services. Processing the objects in an instance of Analysis Services copies the data from the underlying data
sources into the cube objects. For more information, see Deploying Analysis Services Projects1, Configuring Analysis Services Project Properties2

At this point in the development process, you generally deploy the cube to an instance of Analysis Services on a development server. Once you have
finished developing your business intelligence project, you will generally use the Analysis Services Deployment Wizard to deploy your project from the
development server to a production server. For more information, see Planning an Analysis Services Deployment3, Using the Analysis Services Deployment
Wizard4 

In the following task, you review the deployment properties of the Analysis Services Tutorial project and then deploy the project to your local instance
of Analysis Services.

To deploy the Analysis Services project

1. In Solution Explorer, right-click the Analysis Services Tutorial project, and then click Properties.

The Analysis Services Tutorial Property Pages dialog box appears and displays the properties of the Active(Development) configuration. You
can define multiple configurations, each with different properties. For example, a developer might want to configure the same project to deploy to
different development computers and with different deployment properties, such as database names or processing properties. Notice the value for
the Output Path property. This property specifies the location in which the XMLA deployment scripts for the project are saved when a project is
built. These are the scripts that are used to deploy the objects in the project to an instance of Analysis Services.

2. In the Configuration Properties node in the left pane, click Deployment.

Review the deployment properties for the project. By default, the Analysis Services Project template configures an Analysis Services project to
incrementally deploy all projects to the default instance of Analysis Services on the local computer, to create an Analysis Services database with
the same name as the project, and to process the objects after deployment by using the default processing option. Related topic: Configuring
Analysis Services Project Properties2

If you want to deploy the project to a named instance of Analysis Services on the local computer, or to an instance on a remote server,
change the Server property to the appropriate instance name, such as <ServerName>\<InstanceName>.

3. Click OK.

4. In Solution Explorer, right-click the Analysis Services Tutorial project, and then click Deploy.

Business Intelligence Development Studio builds and then deploys the Analysis Services Tutorial project to the specified instance of Analysis
Services by using a deployment script. The progress of the deployment is displayed in two windows: the Output window and the Deployment
3URJUHVV�±�$QDO\VLV�6HUYLFHV�7XWRULDO window. Open the Output window, if necessary, by clicking Output on the View menu. The Output
window displays the overall progress of the deployment. The 'HSOR\PHQW�3URJUHVV�±�$QDO\VLV�6HUYLFHV�7XWRULDO window displays the detail
about each step taken during deployment. Related topics: Building Analysis Services Projects5, Deploying Analysis Services Projects1

5. Review the contents of the Output window and the 'HSOR\PHQW�3URJUHVV�±�$QDO\VLV�6HUYLFHV�7XWRULDO window to verify that the cube was
built, deployed, and processed without errors.

6. Hide the Deployment Progress - Analysis Services Tutorial window by clicking the Auto Hide icon on the toolbar of the window.

7. Hide the Output window by clicking the Auto Hide icon on the toolbar of the window.

You have successfully deployed the Analysis Services Tutorial cube to your local instance of Analysis Services, and then processed the deployed cube.
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Browsing the Cube
SQL Server 2008 R2
After you deploy a cube, the cube data is viewable on the Browser tab in Cube Designer, and the dimension data is viewable on the Browser tab in
Dimension Designer.

To browse the deployed cube

1. Switch to Dimension Designer for the Product dimension in Business Intelligence Development Studio. To do this, double-click the Product
dimension in the Dimensions node of Solution Explorer.

2. Click the Browser tab to display the All member of the Product Key attribute hierarchy. In lesson three, you will define a user hierarchy for the
Product dimension that will let you browse the dimension.

3. Switch to Cube Designer in Business Intelligence Development Studio. To do this, double-click the Analysis Services Tutorial cube in the Cubes
node of Solution Explorer.

4. Select the Browser tab, and then click the reconnect icon on the toolbar of the designer.

The left pane of the designer shows the objects in the Analysis Services Tutorial cube. On the right side of the Browser tab there are two panes:
the upper pane is the Filter pane, and the lower pane is the Data pane. In an upcoming lesson, you will use the cube browser to do analysis.

Lesson 3: Modifying Measures, Attributes and Hierarchies1
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Lesson 3: Modifying Measures, Attributes and Hierarchies
SQL Server 2008 R2
After defining your initial cube, you are ready to improve the usefulness and friendliness of the cube.

A completed project through Lesson 2 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases1.

This lesson contains the following tasks:

Modifying Measures2

In this task, you specify formatting properties for the currency and percentage measures in the Analysis Services Tutorial cube.

Modifying the Customer Dimension3

In this task, you define a user hierarchy, create named calculations, modify attributes to use named calculations, and group attributes and user
hierarchies into display folders.

Modifying the Product Dimension4

In this task, you define a user hierarchy, create named calculations, define the All member name, and define display folders.

Modifying the Date Dimension5

In this task, you define a user hierarchy, modify attribute member names, and use composite keys to specify unique attribute members.

Browsing the Deployed Cube6

In this task, you browse cube data by using the browser in Cube Designer.
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Modifying Measures
SQL Server 2008 R2
You can use the FormatString property to define formatting settings that control how measures are displayed to users. In this task, you specify
formatting properties for the currency and percentage measures in the Analysis Services Tutorial cube.

To modify the measures of the cube

1. Switch to the Cube Structure tab of Cube Designer for the Analysis Services Tutorial cube, expand the Internet Sales measure group in the
Measures pane, right-click Order Quantity, and then click Properties.

2. In the Properties window, click Auto Hide to pin the Properties window open.

It is easier to change properties for several items in the cube when the Properties window remains open.

3. In the Properties window, in the FormatString list, type #,#.

4. On the toolbar of the Cube Structure tab, click Show Measures Grid.

The grid view lets you select multiple measures at the same time.

5. Select the following measures. You can select multiple measures by clicking each while holding down the CTRL key:

Unit Price

Extended Amount

Discount Amount

Product Standard Cost

Total Product Cost

Sales Amount

Tax Amt

Freight

6. In the Properties window, in the FormatString list, select Currency.

7. In the drop-down list at the top of the Properties window, select the measure Unit Price Discount Pct, and then select Percent in the
FormatString list.

8. In the Properties window, change the Name property for the Unit Price Discount Pct measure to Unit Price Discount Percentage.

9. In the Measures pane, click Tax Amt and change the name of this measure to Tax Amount.

10. In the Properties window, click Auto Hide to hide the Properties window, and then click Show Measures Tree on the toolbar of the Cube
Structure tab.

11. On the File menu, click Save All.
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Modifying the Customer Dimension
SQL Server 2008 R2
There are many different ways that you can increase the user-friendliness and functionality of the dimensions in a cube. In the tasks in this topic, you
modify the Customer dimension.

You can change attribute names with the Dimension Structure tab of Dimension Designer.

To rename an attribute

1. Switch to Dimension Designer for the Customer dimension in Business Intelligence Development Studio. To do this, double-click the Customer
dimension in the Dimensions node of Solution Explorer.

2. In the Attributes pane, right-click English Country Region Name and select Rename. Change the name of the attribute to Country-Region.

3. Change the names of the following attributes in the same manner:

English Education�DWWULEXWH�²�FKDQJH�WR�Education

English Occupation�DWWULEXWH�²�FKDQJH�WR�Occupation

State Province Name�DWWULEXWH�²�FKDQJH�WR�State-Province

4. On the File menu, click Save All.

You can create a new hierarchy by dragging an attribute from the Attributes pane to the Hierarchies pane.

To create a hierarchy

1. Drag the Country-Region attribute from the Attributes pane into the Hierarchies pane.

2. Drag the State-Province attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the Country-
Region level.

3. Drag the City attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the State-Province level.

4. In the Hierarchies pane of the Dimension Structure tab, right-click the title bar of the Hierarchy hierarchy, select Rename and type
Customer Geography.

The name of the hierarchy is now Customer Geography.

5. On the File menu, click Save All.

You can add a named calculation, which is a SQL expression that is represented as a calculated column, to a table in a data source view. The
expression appears and behaves as a column in the table. Named calculations let you extend the relational schema of existing tables in a data source
view without modifying the table in the underlying data source. For more information, see Defining Named Calculations in a Data Source View (Analysis
Services)1

To add a named calculation

1. Open the Adventure Works DW data source view by double-clicking it in the Data Source Views folder in Solution Explorer.

2. In the Tables pane, right-click Customer, and then click New Named Calculation.

3. In the Create Named Calculation dialog box, type FullName in the Column name box, and then type the following CASE statement in the
Expression box:

The CASE statement concatenates the FirstName, MiddleName, and LastName columns into a single column that you will use in the
Customer dimension as the displayed name for the Customer attribute.

4. Click OK, and then expand Customer in the Tables pane.

The FullName named calculation appears in the list of columns in the Customer table, with an icon that indicates that it is a named calculation.

5. On the File menu, click Save All.

6. In the Tables pane, right-click Customer, and select Explore Data.

7. Review the last column in the Explore Customer Table view.

Notice that the FullName column appears in the data source view, correctly concatenating data from several columns from the underlying data
source and without modifying the original data source.

8. Close the Explore Customer Table view.

After you have created a named calculation in the data source view, you can use the named calculation as a property of an attribute.

To use the named calculation for member names

1. Switch to Dimension Designer for the Customer dimension.
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Defining Display Folders

Defining Composite KeyColumns

2. In the Attributes pane of the Dimension Structure tab, click the Customer Key attribute.

3. Open the Properties window and click the Auto Hide button on the title bar so that it stays open.

4. In the Name property field, type Full Name.

5. Click in the NameColumn property field and then click the browse («) button to open the Name Column dialog box.

6. Select FullName in the Source column list and then click OK.

7. Drag the Full Name attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the City level.

8. On the File menu, click Save All.

You can use display folders to group user and attribute hierarchies into folder structures to increase user-friendliness.

To define display folders

1. Open the Dimension Structure tab for the Customer dimension.

2. In the Attributes pane, select the following attributes by holding down the CTRL key while clicking each of them:

City

Country-Region

Postal Code

State-Province

3. In the Properties window, click the AttributeHierarchyDisplayFolder property field and type Location.

4. In the Hierarchies pane, click Customer Geography, and then select Location as the value of the DisplayFolder property in the Properties
window.

5. In the Attributes pane, select the following attributes by holding down the CTRL key while clicking each of them:

Commute Distance

Education

Gender

House Owner Flag

Marital Status

Number Cars Owned

Number Children At Home

Occupation

Total Children

Yearly Income

6. In the Properties window, click the AttributeHierarchyDisplayFolder property field and type Demographic.

7. In the Attributes pane, select the following attributes by holding down the CTRL key while clicking each of them:

Email Address

Phone

8. In the Properties window, click the AttributeHierarchyDisplayFolder property field and type Contacts.

9. On the File menu, click Save All.

The KeyColumns property contains the column or columns that represent the key for the attribute. In this lesson, you create a composite key for the
City and State-Province attributes. Composite keys can be helpful when you need to uniquely identify an attribute. For example, when you define
attribute relationships later in this tutorial, a City attribute must uniquely identify a State-Province attribute. However, there could be several cities
with the same name in different states. For this reason, you will create a composite key that is composed of the StateProvinceName and City
columns for the City attribute. For more information, see How to: Modify the KeyColumn Property of an Attribute2.

To define composite KeyColumns for the City attribute

1. Open the Dimension Structure tab for the Customer dimension.

2. In the Attributes pane, click the City attribute.

3. In the Properties window, click in the KeyColumns field and then click the browse (...) button.

4. In the Key Columns dialog box, in the Available Columns list, select the column StateProvinceName, and then click the > button.

The City and StateProvinceName columns are now displayed in the Key Columns list.

5. Click OK.

6. To set the NameColumn property of the City attribute, click in the NameColumn field in the property window and then click the browse (...)
button.

7. In the Name Column dialog box, in the Source Column list, select City and then, click OK.

8. On the File menu, click Save All.

To define composite KeyColumns for the State-Province attribute
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1. Open the Dimension Structure tab for the Customer dimension.

2. In the Attributes pane, click the State-Province attribute.

3. In the Properties window, click in the KeyColumns field and then click the browse (...) button.

4. In the Key Columns dialog box, in the Available Columns list, select the column EnglishCountryRegionName, and then click the > button.

The EnglishCountryRegionName and StateProvinceName columns are now displayed in the Key Columns list.

5. Click OK.

6. To set the NameColumn property of the State-Province attribute, click in the NameColumn field in the property window and then click the
browse (...) button.

7. In the Name Column dialog box, in the Source Column list, select StateProvinceName and then, click OK.

8. On the File menu, click Save All.

If the underlying data supports it, you should define attribute relationships between attributes. Defining attribute relationships speeds up dimension,
partition, and query processing. For more information, see Defining Attribute Relationships3 and Attribute Relationships4.

To define attribute relationships

1. In the Dimension Designer for the Customer dimension, click the Attribute Relationships tab.

2. In the diagram, right-click the City attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is City. Set the Related Attribute to State-Province.

4. In the Relationship type list, set the relationship type to Rigid.

The relationship type is Rigid because relationships between the members will not change over time. For example, it would be unusual for a city
to become part of a different state or province.

5. Click OK.

6. In the diagram, right-click the State-Province attribute and then select New Attribute Relationship.

7. In the Create Attribute Relationship dialog box, the Source Attribute is State-Province. Set the Related Attribute to Country-Region.

8. In the Relationship type list, set the relationship type to Rigid.

9. Click OK.

10. On the File menu, click Save All.

After you have changed attributes and hierarchies, you must deploy the changes and reprocess the related objects before you can view the changes.

To deploy the changes, process the objects, and view the changes

1. On the Build menu of BI Development Studio, click Deploy Analysis Services Tutorial.

2. After you have received the Deployment Completed Successfully message, click the Browser tab of Dimension Designer for the Customer
dimension and then click the reconnect icon on the toolbar of the designer.

3. Verify that Customer Geography is selected in the Hierarchy list, and then in the browser pane expand All, expand Australia, expand New
South Wales, and then expand Coffs Harbour.

The browser displays the customers in the city.

4. Switch to Cube Designer for the Analysis Services Tutorial cube. To do this, double-click the Analysis Services Tutorial cube in the Cubes
node of Solution Explorer.

5. Click the Browser tab, and then click the reconnect icon on the toolbar of the designer.

6. In the Measure Group pane, expand Customer.

Notice that instead of a long list of attributes, only the display folders and the attributes that do not have display folder values appear
underneath Customer.

7. On the File menu, click Save All.
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In the tasks in this topic, you use a named calculation to provide more descriptive names for the product lines, define a hierarchy in the Product
dimension, and specify the (All) member name for the hierarchy. You also group attributes into display folders.

You can add a named calculation to a table in a data source view. In the following task, you create a named calculation that will display the full
product line name.

To add a named calculation

1. Open the Adventure Works DW data source view by double-clicking it in the Data Source Views folder in Solution Explorer.

2. In the diagram pane, right-click the Product table, and then click New Named Calculation.

3. In the Create Named Calculation dialog box, type ProductLineName in the Column name box.

4. In the Expression box, type the following CASE statement:

This CASE statement creates user-friendly names for each product line in the cube.

5. Click OK to create the ProductLineName named calculation.

6. On the File menu, click Save All.

To mod ify the NameColumn property value of an attribute

1. Switch to Dimension Designer for the Product dimension. To do this, double-click the Product dimension in the Dimensions node of Solution
Explorer.

2. In the Attributes pane of the Dimension Structure tab, select Product Line.

3. In the Properties window, click in the NameColumn property field and then click the browse («) button to open the Name Column dialog box.

4. Select ProductLineName in the Source column list and then click OK.

The NameColumn field now contains the text Product.ProductLineName (WChar). The members of the Product Line attribute hierarchy will
now display the full name of the product line instead of an abbreviated product line name.

5. In the Attributes pane of the Dimension Structure tab, select Product Key.

6. In the Properties window, click in the NameColumn property field and then click the ellipsis («) button to open the Name Column dialog box.

7. Select EnglishProductName in the Source column list and then click OK.

The NameColumn field now contains the text Product.EnglishProductName (WChar).

8. In the Properties window, change the value of the Name property for the Product Key attribute to Product Name.

To create a hierarchy

1. Drag the Product Line attribute from the Attributes pane into the Hierarchies pane.

2. Drag the Model Name attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the Product Line
level.

3. Drag the Product Name attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the Model Name
level.

4. In the Hierarchies pane of the Dimension Structure tab, right-click the title bar of the Hierarchy hierarchy, select Rename and type
Product Model Lines.

The name of the hierarchy is now Product Model Lines.

5. On the File menu, click Save All.

To specify the folder and member names

1. In the Attributes pane, select the following attributes by holding down the CTRL key while clicking each of them:

Class

Color

Days To Manufacture

Reorder Point

Safety Stock Level
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Size

Size Range

Style

Weight

2. In the AttributeHierarchyDisplayFolder property field in the Properties window, type Stocking.

You have now grouped these attributes into a single display folder.

3. In the Attributes pane, select the following attributes:

Dealer Price

List Price

Standard Cost

4. In the AttributeHierarchyDisplayFolder property cell in the Properties window, type Financial.

You have now grouped these attributes into a second display folder.

5. In the Attributes pane, select the following attributes:

End Date

Start Date

Status

6. In the AttributeHierarchyDisplayFolder property cell in the Properties window, type History.

You have now grouped these attributes into a third display folder.

7. Select the Product Model Lines hierarchy in the Hierarchies pane, and then change the AllMemberName property in the Properties window
to All Products.

8. Click an open area of the Hierarchies pane, and then change the AttributeAllMemberName property to All Products.

Clicking an open area lets you modify properties of the Product dimension itself. You could also click the Product dimension icon at the top of the
attributes list in the Attributes pane.

9. On the File menu, click Save All.

If the underlying data supports it, you should define attribute relationships between attributes. Defining attribute relationships speeds up dimension,
partition, and query processing. For more information, see Defining Attribute Relationships1 and Attribute Relationships2.

To define attribute relationships

1. In the Dimension Designer for the Product dimension, click the Attribute Relationships tab.

2. In the diagram, right-click the Model Name attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Model Name. Set the Related Attribute to Product Line.

In the Relationship type list, leave the relationship type set to Flexible because relationships between the members might change over time.
For example, a product model might eventually be moved to a different product line.

4. Click OK.

5. On the File menu, click Save All.

To review the Product dimension changes

1. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.

2. After you have received the Deployment Completed Successfully message, click the Browser tab of Dimension Designer for the Product
dimension and then click the reconnect icon on the toolbar of the designer.

3. Verify that Product Model Lines is selected in the Hierarchy list, and then expand All Products.

Notice that the name of the All member appears as All Products. This is because you changed the AllMemberName property for the hierarchy
to All Products earlier in the lesson. Also, the members of the Product Line level now have user-friendly names, instead of single letter
abbreviations.
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SQL Server 2008 R2
In the tasks in this topic, you create a user-defined hierarchy, and change the member names that are displayed for the Date, Month, Calendar Quarter,
and Calendar Semester attributes. You will also define composite keys for attributes, control the sort order of dimension members, and define attribute
relationships.

You can add a named calculation, which is a SQL expression that is represented as a calculated column, to a table in a data source view. The
expression appears and behaves as a column in the table. Named calculations enable you to extend the relational schema of existing tables in a data
source view without modifying the table in the underlying data source. For more information, see Defining Named Calculations in a Data Source View
(Analysis Services)1

To add a named calculation

1. Open the Adventure Works DW data source view by double-clicking it in the Data Source Views folder in Solution Explorer.

2. In the Tables pane, right-click Date, and then click New Named Calculation.

3. In the Create Named Calculation dialog box, type SimpleDate in the Column name box, and then type the following CASE statement in the
Expression box:

The CASE statement extracts the year, month, and day values from the FullDateAlternateKey column. You will use this new column as the
displayed name for the FullDateAlternateKey attribute.

4. Click OK, and then expand Date in the Tables pane.

The SimpleDate named calculation appears in the list of columns in the Customer table, with an icon that indicates that it is a named
calculation.

5. On the File menu, click Save All.

6. In the Tables pane, right-click Date, and select Explore Data.

7. Review the last column in the Explore Customer Table view.

Notice that the SimpleDate column appears in the data source view, correctly concatenating data from several columns from the underlying
data source and without modifying the original data source.

8. Close the Explore Customer Table view.

After you have created a named calculation in the data source view, you can use the named calculation as a property of an attribute.

To use the named calculation for member names

1. Open Dimension Designer for the Date dimension in Business Intelligence Development Studio. To do this, double-click the Date dimension in
the Dimensions node of Solution Explorer.

2. In the Attributes pane of the Dimension Structure tab, click the Date Key attribute.

3. Open the Properties window and click the Auto Hide button on the title bar so that it stays open.

4. Click in the NameColumn property field and then click the ellipsis («) button to open the Name Column dialog box.

5. Select SimpleDate in the Source column list and then click OK.

6. On the File menu, click Save All.

You can create a new hierarchy by dragging an attribute from the Attributes pane to the Hierarchies pane.

To create a hierarchy

1. In Dimension Designer for the Date dimension, drag the Calendar Year attribute from the Attributes pane into the Hierarchies pane.

2. Drag the Calendar Semester attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the
Calendar Year level.

3. Drag the Calendar Quarter attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the Calendar
Semester level.

4. Drag the English Month Name attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the
Calendar Quarter level.

5. Drag the Date Key attribute from the Attributes pane into the <new level> cell in the Hierarchies pane, underneath the English Month
Name level.

6. In the Hierarchies pane, right-click the title bar of the Hierarchy hierarchy, select Rename, and type Calendar Date.

7. In the Calendar Date hierarchy, rename the English Month Name level to Calendar Month and rename the Date Key level to Date.

8. Delete the FullDateAlternateKey attribute from the Attributes pane because you will not be using it.

9. On the File menu, click Save All.
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Providing Unique Dimension Member Names

Defining Composite KeyColumns and Setting the Name Column

If the underlying data supports it, you should define attribute relationships between attributes. Defining attribute relationships speeds up dimension,
partition, and query processing.

To define attribute relationships

1. In the Dimension Designer for the Date dimension, click the Attribute Relationships tab.

2. In the diagram, right-click the English Month Name attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is English Month Name. Set the Related Attribute to Calendar
Quarter.

4. In the Relationship type list, set the relationship type to Rigid.

The relationship type is Rigid because relationships between the members will not change over time.

5. Click OK.

6. In the diagram, right-click the Calendar Quarter attribute and then select New Attribute Relationship.

7. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Quarter. Set the Related Attribute to Calendar
Semester.

8. In the Relationship type list, set the relationship type to Rigid.

9. Click OK.

10. In the diagram, right-click the Calendar Semester attribute and then select New Attribute Relationship.

11. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Semester. Set the Related Attribute to Calendar Year.

12. In the Relationship type list, set the relationship type to Rigid.

13. Click OK.

14. On the File menu, click Save All.

In this task, you will create user-friendly name columns that will be used by the EnglishMonthName, CalendarQuarter, and CalendarSemester
attributes.

To provide unique dimension member names

1. Switch to the Adventure Works DW data source view by double-clicking it in the Data Source Views folder in Solution Explorer.

2. In the Tables pane, right-click Date, and then click New Named Calculation.

3. In the Create Named Calculation dialog box, type MonthName in the Column name box, and then type the following statement in the
Expression box:

The statement concatenates the month and year for each month in the table into a new column.

4. Click OK.

5. In the Tables pane, right-click Date, and then click New Named Calculation.

6. In the Create Named Calculation dialog box, type CalendarQuarterDesc in the Column name box, and then type the following SQL script in
the Expression box:

This SQL script concatenates the calendar quarter and year for each quarter in the table into a new column.

7. Click OK.

8. In the Tables pane, right-click Date, and then click New Named Calculation.

9. In the Create Named Calculation dialog box, type CalendarSemesterDesc in the Column name box, and then type the following SQL script
in the Expression box:

This SQL script concatenates the calendar semester and year for each semester in the table into a new column.

10. Click OK.

11. On the File menu, click Save All.

The KeyColumns property contains the column or columns that represent the key for the attribute. In this task, you will define composite
KeyColumns.

To define composite KeyColumns for the English Month Name attribute

1. Open the Dimension Structure tab for the Date dimension.
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Deploying and Viewing the Changes

Changing the Sort Order by Modifying Composite Key Member Order

2. In the Attributes pane, click the English Month Name attribute.

3. In the Properties window, click in the KeyColumns field and then click the browse (...) button.

4. In the Key Columns dialog box, in the Available Columns list, select the column CalendarYear, and then click the > button.

5. The EnglishMonthName and CalendarYear columns are now displayed in the Key Columns list.

6. Click OK.

7. To set the NameColumn property of the EnglishMonthName attribute, click in the NameColumn field in the property window and then click
the browse (...) button.

8. In the Name Column dialog box, in the Source Column list, select MonthName and then, click OK.

9. On the File menu, click Save All.

To define composite KeyColumns for the Calendar Quarter attribute

1. In the Attributes pane, click the Calendar Quarter attribute.

2. In the Properties window, click in the KeyColumns field and then click the browse (...) button.

3. In the Key Columns dialog box, in the Available Columns list, select the column CalendarYear, and then click the > button.

The CalendarQuarter and CalendarYear columns are now displayed in the Key Columns list.

4. Click OK.

5. To set the NameColumn property of the Calendar Quarter attribute, click in the NameColumn field in the properties window and then click
the browse (...) button.

6. In the Name Column dialog box, in the Source Column list, select CalendarQuarterDesc and then, click OK.

7. On the File menu, click Save All.

To define composite KeyColumns for the Calendar Semester attribute

1. In the Attributes pane, click the Calendar Semester attribute.

2. In the Properties window, click in the KeyColumns field and then click the browse (...) button.

3. In the Key Columns dialog box, in the Available Columns list, select the column CalendarYear, and then click the > button.

The CalendarSemester and CalendarYear columns are now displayed in the Key Columns list.

4. Click OK.

5. To set the NameColumn property of the Calendar Semester attribute, click in the NameColumn field in the property window and then click
the browse (...) button.

6. In the Name Column dialog box, in the Source Column list, select CalendarSemesterDesc and then, click OK.

7. On the File menu, click Save All.

After you have changed attributes and hierarchies, you must deploy the changes and reprocess the related objects before you can view the changes.

To deploy and view the changes

1. On the Build menu of BI Development Studio, click Deploy Analysis Services Tutorial.

2. After you have received the Deployment Completed Successfully message, click the Browser tab of Dimension Designer for the Date
dimension and then click the reconnect icon on the toolbar of the designer.

3. Select Calendar Quarter from the Hierarchy list. Review the members in the Calendar Quarter attribute hierarchy.

Notice that the names of the members of the Calendar Quarter attribute hierarchy are more user-friendly because you created a named
calculation to use as the name. Members now exist in the Calendar Quarter attribute hierarchy for each quarter in each year The members are
not sorted in chronological order. Instead they are sorted by quarter and then by year. In the next task in this topic, you will modify this
behavior to sort the members of this attribute hierarchy by year and then by quarter.

4. Review the members of the English Month Name and Calendar Semester attribute hierarchies.

Notice that the members of these hierarchies are also not sorted in chronological order. Instead, they are sorted by month or semester,
respectively, and then by year. In the next task in this topic, you will modify this behavior to change this sort order.

In this task, you will change the sort order by changing the order of the keys that make up the composite key.

To modify the composite key member order

1. Select the Dimension Structure tab of Dimension Designer for the Date dimension, and then select Calendar Semester in the Attributes
pane.

2. In the Properties window, review the value for the OrderBy property. It is set to Key.

The members of the Calendar Semester attribute hierarchy are sorted by their key value. With a composite key, the ordering of the member
keys is based first on the value of the first member key, and then on the value of the second member key. In order words, the members of the
Calendar Semester attribute hierarchy are sorted first by semester and then by year.

3. In the Properties window, click the ellipsis button (...) to change the KeyColumns property value.

4. In the Key Columns list of the Key Columns dialog box, verify that CalendarSemester is selected, and then click the down arrow to reverse
the order of the members of this composite key. Click OK.

The members of the attribute hierarchy are now sorted first by year and then by semester.
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5. Select Calendar Quarter in the Attributes pane, and then click the ellipsis button (...) for the KeyColumns property in the Properties window.

6. In the Key Columns list of the Key Columns dialog box, verify that CalendarQuarter is selected, and then click the down arrow to reverse
the order of the members of this composite key. Click OK.

The members of the attribute hierarchy are now sorted first by year and then by quarter.

7. Select English Month Name in the Attributes pane, and then click the ellipsis button (...) for the KeyColumns property in the Properties
window.

8. In the Key Columns list of the Key Columns dialog box, verify that EnglishMonthName is selected, and then click the down arrow to reverse
the order of the members of this composite key. Click OK.

The members of the attribute hierarchy are now sorted first by year and then by month.

9. On the Build menu of BI Development Studio, click Deploy Analysis Services Tutorial. When deployment has successfully completed, click the
Browser tab in Dimension Designer for the Date dimension.

10. On the toolbar of the Browser tab, click the reconnect icon.

11. Review the members of the Calendar Quarter and Calendar Semester attribute hierarchies.

Notice that the members of these hierarchies are now sorted in chronological order, by year and then by quarter or semester, respectively.

12. Review the members of the English Month Name attribute hierarchy.

Notice that the members of the hierarchy are now sorted first by year and then alphabetically by month. This is because the data type for the
EnglishCalendarMonth column in the data source view is a string column - based on the nvarchar data type in the underlying relational database.
For information about how to enable the months to be sorted chronologically within each year, see Sorting Attribute Members Based on a
Secondary Attribute2.
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Browsing the Deployed Cube
SQL Server 2008 R2
In the following task, you browse the Analysis Services Tutorial cube.

To browse the deployed cube

1. Switch to Cube Designer in BI Development Studio by clicking the Analysis Services Tutorial cube.

2. Select the Browser tab, and then click Reconnect on the toolbar of the designer.

The left pane of the designer shows the metadata for the Analysis Services Tutorial cube. Notice that Perspective and Language options are
available on the toolbar of the Browser tab. Notice also that the Browser tab includes two panes to the right of the metadata pane: the upper
pane is the filter pane, and the lower pane is the data pane.

The following image highlights the individual panes in Cube Designer.

3. In the metadata pane, expand Measures, expand Internet Sales, and then drag the Sales Amount measure to the Drop Totals or Detail Fields
Here area of the Data pane.

4. In the metadata pane, expand Product.

Notice that the attribute and user hierarchies are organized into display folders in the Product metadata list.

5. Drag the Product Model Lines user hierarchy to the Drop Column Fields Here area of the data pane, and then expand the Road member of the
Product Line level of this user hierarchy.

Notice that the user hierarchy provides a path to the product name level.

6. In the metadata pane, expand Customer, expand Location, and then drag the Customer Geography hierarchy from the Location display folder
in the Customer dimension to the Drop Row Fields Here area of the data pane.

7. On the row axis, expand United States to view the sales details by region within the United States.

8. Expand Oregon to view the sales details by city within the state of Oregon.

9. In the metadata pane, expand Order Date and then drag the Order Date.Calendar Date hierarchy to the Drop Filter Fields Here area of the
Data pane.

10. Click the arrow to the right of the Order Date.Calendar Date filter in the data pane, clear the check box for the (All) level, expand 2002,
expand H1 CY 2002, expand Q1 CY 2002, select the check box for February 2002, and then click OK.

Internet sales by region and product line for the month of February, 2002 appear as shown in the following image.
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11. In the metadata pane, expand Customer, expand Demographic, expand the Commute Distance attribute hierarchy, expand Members, and
then expand All.

12. Right-click the 10+ Miles member, and then click Add to Subcube Area.

Commute Distance appears in the filter pane, above the data pane. The values that are displayed in the data pane are now filtered to show data
for customers who commute more than 10 miles. This is effectively equal to the WHERE clause in a Multidimensional Expressions (MDX) query
statement. For more information, see MDX Query Fundamentals (MDX)1.

13. On the File menu, click Save All.
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Lesson 4: Defining Advanced Attribute and Dimension Properties
SQL Server 2008 R2
In this lesson, you will learn how to use some of the advanced properties of attributes, attribute hierarchies, and dimension properties.

This lesson is based on an enhanced version of the Analysis Services Tutorial project that you completed in the first three lessons of this tutorial.
The first task in this lesson describes where to locate the appropriate sample project to use for the lesson, and the difference between this project
and the project that you created in the first three lessons.

This lesson contains the following tasks:

Using a Modified Version of the Analysis Services Tutorial Project1

In this task, you open, review, and deploy a modified version of the Analysis Services Tutorial project which has multiple measure groups and
additional dimensions.

Defining Parent Attribute Properties in a Parent-Child Hierarchy2

In this task, you define level names in a parent-child dimension and specify whether data related to parent members will be displayed. For more
information, see Defining a Parent-Child Hierarchy3, and Working with Attributes in Parent-Child Hierarchies4.

Automatically Grouping Attribute Members5

In this task, you automatically create groupings of attribute members based on the distribution of the members within the attribute hierarchy. For
more information, see Grouping Attribute Members (Discretization)6.

Hiding and Disabling Attribute Hierarchies7

In this task, you learn how and when to disable or hide attribute hierarchies.

Sorting Attribute Members Based on a Secondary Attribute8

In this task, you learn how to sort dimension members based on a secondary attribute, to achieve the sort order that you want.

Specifying Attribute Relationships Between Attributes in a User-Defined Hierarchy9

In this task, you learn how to define member properties for attributes, to specify aggregation relationships between them. For more information,
see Defining Attribute Relationships10, and User Hierarchy Properties11.

Defining the Unknown Member and Null Processing Properties12

In this task, you configure the UnknownMember and UnknownMemberName properties to handle error conditions caused by null dimension
members.
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Note

Loading and Processing the Enhanced Project

Understanding the Enhancements to the Project

Using a Modified Version of the Analysis Services Tutorial
Project
SQL Server 2008 R2
The remaining lessons in this tutorial are based on an enhanced version of the Analysis Services Tutorial project that you completed in the first three
lessons. Additional tables and named calculations have been added to the Adventure Works DW data source view, additional dimensions have been added
to the project, and these new dimensions have been added to the Analysis Services Tutorial cube. In addition, a second measure group has been added,
which contains measures from a second fact table. This enhanced project will enable you to continue learning how to add functionality to your business
intelligence application without having to repeat the skills you have already learned.

Before you can continue with the tutorial, you must load and process the enhanced version of the Analysis Services Tutorial project.

To obtain the updated version of this enhanced tutorial project required to continue with this tutorial, you must download the samples. For more
information, see Considerations for Installing SQL Server Samples and Sample Databases1.

To load and process the enhanced tutorial project

1. On the File menu, click Close Solution.

2. On the File menu, point to Open, and then click Project/Solution.

3. Browse to C:\Program Files\Microsoft SQL Server\100\Samples\Analysis Services\Tutorials\Lesson4 Start, and then double-click Analysis Services
Tutorial.sln.

4. Deploy the enhanced version of the Analysis Services Tutorial project to the local instance of Analysis Services, or to another instance, and
verify that processing completes successfully.

The enhanced version of the project is different from the version of the Analysis Services Tutorial project that you completed in the first three
lessons. The differences are described in the following sections. Review this information before continuing with the remaining lessons in the tutorial.

Data Source View

The data source view in the enhanced project contains one additional fact table and four additional dimension tables from the
AdventureWorksDW2008 database.

Notice that with ten tables in the data source view, the <All Tables> diagram is becoming crowded. This makes it difficult to easily understand the
relationships between the tables and to locate specific tables. To solve this problem, the tables are organized into two logical diagrams, the Internet
Sales diagram and the Reseller Sales diagram. These diagrams are each organized around a single fact table. Creating logical diagrams lets you view
and work with a specific subset of the tables in a data source view instead of always viewing all the tables and their relationships in a single diagram.

Internet Sales Diagram

The Internet Sales diagram contains the tables that are related to the sale of Adventure Works products directly to customers through the Internet.
The tables in the diagram are the four dimension tables and one fact table that you added to the Analysis Services Tutorial data source view in Lesson
1. These tables are as follows:

Geography

Customer

Date

Product

InternetSales

Reseller Sales Diagram

The Reseller Sales diagram contains the tables that are related to the sale of Adventure Works products by resellers. This diagram contains the
following seven dimension tables and one fact table from the AdventureWorksDW2008 database:

Reseller

Promotion

SalesTerritory

Geography

Date

Product

Employee

ResellerSales

Notice that the DimGeography, DimDate, and DimProduct tables are used in both the Internet Sales diagram and the Reseller Sales diagram.
Dimension tables can be linked to multiple fact tables.

Database and Cube D imensions

The Analysis Services Tutorial project contains five new database dimensions, and the Analysis Services Tutorial cube contains these same five
dimensions as cube dimensions. These dimensions have been defined to have user hierarchies and attributes that were modified by using named
calculations, composition member keys, and display folders. The new dimensions are described in the following list.

Reseller Dimension
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The Reseller dimension is based on the Reseller table in the Adventure Works DW data source view.

Promotion Dimension

The Promotion dimension is based on the Promotion table in the Adventure Works DW data source view.

Sales Territory Dimension

The Sales Territory dimension is based on the SalesTerritory table in the Adventure Works DW data source view.

Employee Dimension

The Employee dimension is based on the Employee table in the Adventure Works DW data source view.

Geography Dimension

The Geography dimension is based on the Geography table in the Adventure Works DW data source view.

Analysis Services Cube

The Analysis Services Tutorial cube now contains two measure groups, the original measure group based on the InternetSales table and a second
measure group based on the ResellerSales table in the Adventure Works DW data source view. 
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Note

Browsing the Employee Dimension

M odifying Parent Attribute Properties in the Employee Dimension

Defining Parent Attribute Properties in a Parent-Child Hierarchy
SQL Server 2008 R2
A parent-child hierarchy is a hierarchy in a dimension that is based on two table columns. Together, these columns define the hierarchical relationships
among the members of the dimension. The first column, called the member key column, identifies each dimension member. The other column, called the
parent column, identifies the parent of each dimension member. The NamingTemplate property of a parent attribute determines the name of each level
in the parent-child hierarchy, and the MembersWithData property determines whether data for parent members should be displayed.

For more information, see Defining a Parent-Child Hierarchy1, Working with Attributes in Parent-Child Hierarchies2

When you use the Dimension Wizard to create a dimension, the wizard recognizes the tables that have parent-child relationships and automatically
defines the parent-child hierarchy for you.

In the tasks in this topic, you will create a naming template that defines the name for each level in the parent-child hierarchy in the Employee
dimension. You will then configure the parent attribute to hide all parent data, so that only the sales for leaf-level members are displayed.

To browse the Employee dimension

1. In Solution Explorer, double-click Employee.dim in the Dimensions folder to open Dimension Designer for the Employee dimension.

2. Click the Browser tab, verify that Employees is selected in the Hierarchy list, and then expand the All Employees member.

Notice that .HQ�-��6iQFKH] is the top-level manager in this parent-child hierarchy.

3. Select the .HQ�-��6iQFKH] member.

Notice that the level name for this member is Level 02. (The level name appears after Current level: immediately above the All Employees
member.) In the next task, you will define more descriptive names for each level.

4. Expand .HQ�-��6iQFKH] to view the names of the employees who report to this manager, and then select Brian S. Welcker to view the name of
this level.

Notice that the level name for this member is Level 03.

5. In Solution Explorer, double-click Analysis Services Tutorial.cube in the Cubes folder to open Cube Designer for the Analysis Services Tutorial
cube.

6. Click the Browser tab.

7. In the Metadata pane, expand Measures, expand Reseller Sales, right-click Reseller Sales-Sales Amount, and then select Add to Data
Area.

8. In the metadata pane, expand Employee, and then drag the Employees hierarchy to the Drop Row Fields Here area of the Data pane.

All the members of the Employees hierarchy are added to the Data pane in a collapsed view.

9. In the Data pane, expand the Level 02 column of the Employees hierarchy, and then continue expanding levels to view the members of levels
02 through 05.

The following image shows the Data pane with levels 02 through 05 of the Employees hierarchy expanded.

Notice that the sales made by each manager in Level 04 are also displayed in Level 05. This is because each manager is also an employee of
another manager. In the next task, you will hide these sale amounts.

To modify parent attribute properties in the Employee dimension
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Browsing the Employee Dimension with the M odified Attributes

1. Switch to Dimension Designer for the Employee dimension.

2. Click the Dimension Structure tab, and then select the Employees attribute hierarchy in the Attributes pane.

Notice the unique icon for this attribute. This icon signifies that the attribute is the parent key in a parent-child hierarchy. Notice also, in the
Properties window, that the Usage property for the attribute is defined as Parent. This property was set by the Dimension Wizard when the
dimension was designed. The wizard automatically detected the parent-child relationship.

3. In the Properties window, click the ellipsis button (...) in the NamingTemplate property cell.

In the Level Naming Template dialog box, you define the level naming template that determines the level names in the parent-child hierarchy
that are displayed to users as they browse cubes.

4. In the second row, the * row, type Employee Level * in the Name column, and then click the third row.

Notice under Result that each level will now be named "Employee Level" followed by a sequentially increasing number.

The following image shows the changes in the Level Naming Template dialog box.

5. Click OK.

6. In the Properties window for the Employees attribute, in the MembersWithData property cell, select NonLeafDataHidden to change this
value for the Employees attribute.

This will cause data that is related to non-leaf level members in the parent-child hierarchy to be hidden.

To browse the Employee dimension

1. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to Cube Designer for the Analysis Services Tutorial cube, and then click Reconnect on the
toolbar of the Browser tab.

3. In the left pane of the designer, select Employees in the Employee dimension, and then drag this hierarchy to the Drop Row Fields Here area.
Expand the hierarchy several times to display the first five levels.

Notice that the level names are now more descriptive and that the sales values for each manager are no longer displayed. However, notice also
that the total for each level displays the total for each employee, including the hidden amount for the manager. In Lesson 10 you will learn how
to enable visual totals so that the total for Employee Level 05 reflects only those values that are actually visible to the user.

The following image shows the changes that you made to the Employees hierarchy.
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Grouping Attribute Hierarchy Members in the Customer Dimension

Automatically Grouping Attribute Members
SQL Server 2008 R2
When you browse a cube, you typically dimension the members of one attribute hierarchy by the members of another attribute hierarchy. For example,
you might group customer sales by city, by product purchased, or by gender. However, with certain types of attributes, it is useful to have
Microsoft Analysis Services automatically create groupings of attribute members based on the distribution of the members within an attribute hierarchy.
For example, you can have Analysis Services create groups of yearly income values for customers. When you do this, users who browse the attribute
hierarchy will see the names and values of the groups instead of the members themselves. This limits the number of levels that are presented to users,
which can be more useful for analysis.

The DiscretizationMethod property determines whether Analysis Services creates groupings, and determines the type of grouping that is performed. By
default, Analysis Services does not perform any groupings. When you enable automatic groupings, you can allow Analysis Services to automatically
determine the best grouping method based on the structure of the attribute, or you can choose one of the grouping algorithms in the following list to
specify the grouping method:

EqualAreas

Analysis Services creates group ranges so that the total population of dimension members is distributed equally across the groups.

Clusters

Analysis Services creates groups by performing single-dimensional clustering on the input values by using the K-Means clustering method with
Gaussian distributions. This option is valid only for numeric columns.

After you specify a grouping method, you must specify the number of groups, by using the DiscretizationBucketCount property. For more information,
see Grouping Attribute Members (Discretization)1

In the tasks in this topic, you will enable different types of groupings for the following: the yearly income values in the Customer dimension; the number
of employee sick leave hours in the Employees dimension; and the number of employee vacation hours in the Employees dimension. You will then
process and browse the Analysis Services Tutorial cube to view the effect of the member groups. Finally, you will modify the member group properties to
see the effect of the change in grouping type.

To group attribute hierarchy members in the Customer D imension

1. In Solution Explorer, double-click Customer in the Dimensions folder to open Dimension Designer for the Customer dimension.

2. In the Data Source View pane, right-click the Customer table, and then click Explore Data.

Notice the range of values for the YearlyIncome column. These values become the members of the Yearly Income attribute hierarchy, unless
you enable member grouping.

3. Close the Explore Customer Table tab.

4. In the Attributes pane, select Yearly Income.

5. In the Properties window, change the value for the DiscretizationMethod property to Automatic and change the value for the
DiscretizationBucketCount property to 5.

The following image shows the modified properties for Yearly Income.
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Browsing the M odified Attribute Hierarchies

M odifying Grouping Properties and Reviewing the Effect of the Changes

To group attribute hierarchy members in the Employee dimension

1. Switch to Dimension Designer for the Employee dimension.

2. In the Data Source View pane, right-click the Employee table, and then click Explore Data.

Notice the values for the SickLeaveHours column and the VacationHours column.

3. Close the Explore Employee Table tab.

4. In the Attributes pane, select Sick Leave Hours.

5. In the Properties window, change the value for the DiscretizationMethod property to Clusters and change the value for the
DiscretizationBucketCount property to 5.

6. In the Attributes pane, select Vacation Hours.

7. In the Properties window, change the value for the DiscretizationMethod property to Equal Areas and change the value for the
DiscretizationBucketCount property to 5.

To browse the modified attribute hierarchies

1. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to Cube Designer for the Analysis Services Tutorial cube, and then click Reconnect on the
Browser tab.

3. Remove all the levels of the Employees hierarchy from the row field area of the data pane and remove all measures from the data pane. To do
this, right-click in the data pane and click Clear Results.

4. Add the Internet Sales-Sales Amount measure to the data area of the data pane. To do this, right-click Internet Sales-Sales Amount and
select Add to Data Area.

5. In the metadata pane, expand the Product dimension, and thendrag the Product Model Lines user hierarchy to the Drop Row Fields Here
area of the data pane.

6. Expand the Customer dimension in the Metadata pane, expand the Demographic display folder, and then drag the Yearly Income attribute
hierarchy to the Drop Column Fields Here area.

The members of the Yearly Income attribute hierarchy are now grouped into six buckets, including a bucket for sales to customers whose
yearly income is unknown. Not all buckets are displayed.

7. Remove the Yearly Income attribute hierarchy from the column area and remove the Internet Sales-Sales Amount measure of the Data
pane.

8. Add the Reseller Sales-Sales Amount measure to the data area.

9. In the metadata pane, expand the Employee dimension, expand Organization, right-click Sick Leave Hours, and then click Add to Column
Area.

Notice that all sales are made by employees within one of two groups. (If you want to see the three groups that have no sales, right-click the
data area and then click Show Empty Cells). Notice also that the employees with 32 - 42 sick leave hours made significantly more sales than
employees with 20 - 31 sick leave hours.

The following image shows sales dimensioned by employee sick leave hours.

10. Remove the Sick Leave Hours attribute hierarchy from the column area of the Data pane.

11. Add Vacation Hours to the column area of the Data pane.

Notice that two groups appear, based on the equal areas grouping method. Three other groups are hidden because they contain no data values.

To modify the grouping properties and review the effect of the changes

1. Switch to Dimension Designer for the Employee dimension, and then select Vacation Hours in the Attributes pane.

2. In the Properties window, change the value of the DiscretizationBucketCount property to 10.

3. On the Build menu of BI Development Studio, click Deploy Analysis Services Tutorial.

4. When deployment has successfully completed, switch back to Cube Designer for the Analysis Services Tutorial cube.

5. Click Reconnect on the Browser tab, and then view the effect of the change to the grouping method.

Notice that there are now three groups of members of the Vacation Hours attribute that have sales values for products. (The other seven
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groups contain members with no sales data.)
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Note

Setting Attribute Hierarchy Properties in the Employee Dimension

Hiding and Disabling Attribute Hierarchies
SQL Server 2008 R2
By default, an attribute hierarchy is created for every attribute in a dimension, and each hierarchy is available for dimensioning fact data. This hierarchy
consists of an "All" level and a detail level containing all members of the hierarchy. As you have already learned, you can organize attributes into user-
defined hierarchies to provide navigation paths in a cube. Under certain circumstances, you may want to disable or hide some attributes and their
hierarchies. For example, certain attributes such as social security numbers or national identification numbers, pay rates, birth dates, and login
information are not attributes by which users will dimension cube information. Instead, this information is generally only viewed as details of a particular
attribute member. You may want to hide these attribute hierarchies, leaving the attributes visible only as member properties of a specific attribute. You
may also want to make members of other attributes, such as customer names or postal codes, visible only when they are viewed through a user
hierarchy instead of independently through an attribute hierarchy. One reason to do so may be the sheer number of distinct members in the attribute
hierarchy. Finally, to improve processing performance, you should disable attribute hierarchies that users will not use for browsing.

The value of the AttributeHierarchyEnabled property determines whether an attribute hierarchy is created. If this property is set to False, the
attribute hierarchy is not created and the attribute cannot be used as a level in a user hierarchy; the attribute hierarchy exists as a member property
only. However, a disabled attribute hierarchy can still be used to order the members of another attribute. If the value of the
AttributeHierarchyEnabled property is set to True, the value of the AttributeHierarchyVisible property determines whether the attribute hierarchy
is visible independent of its use in a user-defined hierarchy.

When an attribute hierarchy is enabled, you may want to specify values for the following three additional properties:

IsAggregatable

By default, an (All) level is defined for all attribute hierarchies. To disable the (All) level for an enabled attribute hierarchy, set the value for this
property to False.

An attribute that has its IsAggregatable property set to false can only be used as the root of a user-defined hierarchy and must have a
default member specified (otherwise, one will be chosen for you by the Analysis Services engine).

AttributeHierarchyOrdered

By default, Analysis Services orders the members of enabled attribute hierarchies during processing, and then stores the members by the value of
the OrderBy property, such as by Name or Key. If you do not care about ordering, you can increase processing performance by setting the value
of this property to False.

AttributeHierarchyOptimizedState

By default, Analysis Services creates an index for each enabled attribute hierarchy during processing, to improve query performance. If you do not
plan to use an attribute hierarchy for browsing, you can increase processing performance by setting the value of this property to NotOptimized.
However, if you use a hidden hierarchy as the key attribute for the dimension, creating an index of the attribute members will still improve
performance.

These properties do not apply if an attribute hierarchy is disabled.

In the tasks in this topic, you will disable social security numbers and other attributes in the Employee dimension that will not be used for browsing. You
will then hide the customer name and postal code attribute hierarchies in the Customer dimension. The large number of attribute members in these
hierarchies will make browsing these hierarchies very slow independent of a user hierarchy.

To set the attribute hierarchy properties in the Employee dimension

1. Switch to Dimension Designer for the Employee dimension, and then click the Browser tab.

2. Verify that the following attribute hierarchies appear in the Hierarchy list:

Base Rate

Birth Date

Login ID

Manager SSN

SSN

3. Switch to the Dimension Structure tab, and then select the following attributes in the Attributes pane. You can select multiple measures by
clicking each while holding down the CTRL key:

Base Rate

Birth Date

Login ID

Manager SSN

SSN

4. In the Properties window, set the value of the AttributeHierarchyEnabled property to False for the selected attributes.

Notice in the Attributes pane that the icon for each attribute has changed to indicate that the attribute is not enabled.

The following image shows the AttributeHierarchyEnabled property set to False for the selected attributes.
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Setting Attribute Hierarchy Properties in the Customer Dimension

5. On the Build menu, click Deploy Analysis Services Tutorial.

6. When processing has successfully completed, switch to the Browser tab, click Reconnect, and then try to browse the modified attribute
hierarchies.

Notice that the members of the modified attributes are not available for browsing as attribute hierarchies in the Hierarchy list. If you try to add
one of the disabled attribute hierarchies as a level in a user hierarchy, you will receive an error notifying you that the attribute hierarchy must be
enabled to participate in a user-defined hierarchy.

To set the attribute hierarchy properties in the Customer d imension

1. Switch to Dimension Designer for the Customer dimension, and then click the Browser tab.

2. Verify that the following attribute hierarchies appear in the Hierarchy list:

Full Name

Postal Code

3. Switch to the Dimension Structure tab, and then select the following attributes in the Attributes pane by using the CTRL key to select
multiple attributes at the same time:

Full Name

Postal Code

4. In the Properties window, set the value of the AttributeHierarchyVisible property to False for the selected attributes.

Because the members of these attribute hierarchies will be used for dimensioning fact data, ordering and optimizing the members of these
attribute hierarchies will improve performance. Therefore, the properties of these attributes should not be changed.

The following image shows the AttributeHierarchyVisible property set to False.
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5. Drag the Postal Code attribute from the Attributes pane into the Customer Geography user hierarchy in the Hierarchies and Levels pane,
immediately under the City level.

Notice that a hidden attribute can still become a level in a user hierarchy.

6. On the Build menu, click Deploy Analysis Services Tutorial.

7. When deployment has successfully completed, switch to the Browser tab for the Customer dimension, and then click Reconnect.

8. Try to select either of the modified attribute hierarchies from the Hierarchy list.

Notice that neither of the modified attribute hierarchies appears in the Hierarchy list.

9. In the Hierarchy list, select Customer Geography, and then browse each level in the browser pane.

Notice that the hidden levels, Postal Code and Full Name, are visible in the user-defined hierarchy.

Sorting Attribute Members Based on a Secondary Attribute1
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 Note

Defining an Attribute Relationship and Sort Order in the Date Dimension

Sorting Attribute Members Based on a Secondary Attribute
SQL Server 2008 R2
In Lesson 3, you learned how to sort attribute members based on either their name or key value. You also learned how to use a composite member key
to affect attribute members and sort order. For more information, see Modifying the Date Dimension1. However, sometimes you might want to order
attribute members based on a secondary attribute. For example, if neither the name nor the key of the primary attribute provide the sort order that you
want, you might use a secondary attribute to achieve the desired sort order. However, in order to sort an attribute by a secondary attribute name or
key, you must use a secondary attribute that is related to the primary attribute.

Attribute relationships define the relationships or dependencies between attributes. In a dimension that is based on a single relational table, all attributes
are typically related to each other through the key attribute. This is because all the attributes for a dimension provide information about the members
linked by the key attribute of the dimension to the facts in the fact table for each related measure group. In a dimension that is based on multiple tables,
attributes are typically linked based on the join key between the tables.

However, users might also be interested in additional information about members at a particular level in a hierarchy. Dimension Designer lets you define
additional relationships between attributes or change the default relationships to increase performance. The main constraint when you create an
attribute relationship is to make sure that the attribute referred to has no more than one value for any member in the attribute to which it is related.
When you define a relationship between two attributes, you can define the relationship as rigid or flexible, based on whether the relationships between
members will change over time. For example, an employee might move to a different sales region, but a city will not move to a different state. If a
relationship is defined as rigid, attribute aggregations are not recalculated every time the dimension is incrementally processed. However, if the
relationship between members does change, the dimension must be fully processed. For more information, see Attribute Relationships2, Defining Attribute
Relationships3, Configuring Attribute Relationship Properties4, and Specifying Attribute Relationships Between Attributes in a User-Defined Hierarchy5.

In the tasks in this topic, you will define a new attribute in the Date dimension based on an existing column in the underlying dimension table. You will
use this new attribute to sort calendar month members chronologically instead of alphabetically. You will also define a new attribute in the Customer
dimension based on the named calculation that you will use to sort the Commute Distance attribute members. In the tasks in the next topic, you will
learn to use attribute relationships to increase query performance.

To define an attribute relationship and sort order in the Date dimension

1. Open Dimension Designer for the Date dimension, and then review the OrderBy property for the Month Name attribute in the Properties
window.

Notice that the Month Name attribute members are ordered by their key values.

2. Switch to the Browser tab, verify that Calendar Date is selected in the Hierarchy list, and then expand the levels in the user-defined
hierarchy to review the sort order for the calendar months.

Notice that the members of the attribute hierarchy are sorted based on the ASCII values of their member keys, which are month and year. In
this case, sorting by the attribute name or key does not sort calendar months chronologically. To solve this, you will sort the members of the
attribute hierarchy based on a new attribute, the MonthNumberOfYear attribute. You will create this attribute based on a column that
conveniently exists in the Date dimension table.

3. Switch to the Dimension Structure tab for the Date dimension, right-click MonthNumberOfYear in the Data Source View pane, and then
click New Attribute from Column.

4. In the Attributes pane, select Month Number Of Year, and then set the AttributeHierarchyEnabled property to False in the Properties
window, set the AttributeHierarchyOptimizedState property to NotOptimized, and set the AttributeHierarchyOrdered property to False.

These settings will hide the attribute from users and will improve processing time. This attribute will not be used for browsing. It will only be used
for ordering the members of another attribute.

Sorting properties in the Properties window alphabetically will simplify this task as these three properties will be sorted adjacent to each
other.

5. Click the Attribute Relationships tab.

Notice that all the attributes in the Date dimension are related directly to the Date attribute, which is the member key that relates the
dimension members to the facts in the related measure groups. There is no relationship defined between the Month Name attribute and the
Month Number Of Year attribute.

6. In the diagram, right-click the Month Name attribute and then select New Attribute Relationship.

7. In the Create Attribute Relationship dialog box, the Source Attribute is Month Name. Set the Related Attribute to Month Number Of
Year.

8. In the Relationship type list, set the relationship type to Rigid.

The relationships between the members of the Month Name attribute and the Month Number Of Year attribute will not change over time. As a
result, Analysis Services will not drop aggregations for this relationship during incremental processing. If a change does occur, a processing error
will occur during incremental processing and you will need to perform a full process of the dimension. You are now ready to set the sort order for
the members of Month Name.

9. Click OK.

10. Click the Dimension Structure tab.

11. Select Month Name in the Attributes pane, and then change the value of the OrderBy property in the Properties window to AttributeKey and
change the value of the OrderByAttribute property to Month Number Of Year.

12. On the Build menu, click Deploy Analysis Services Tutorial.

13. When deployment has successfully completed, switch to the Browser tab for the Date dimension, click Reconnect, and then browse the
Calendar Date and Fiscal Date user hierarchies to verify that months now sort in chronological order.

Notice that the months are now sorted in chronological order, as shown in the following image.
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Defining Attribute Relationships and Sort Order in the Customer Dimension

Next Task in Lesson

To define the attribute relationships and sort order in the Customer d imension

1. Switch to the Browser tab in Dimension Designer for the Customer dimension, and then browse the members of the Commute Distance
attribute hierarchy.

Notice that the members of this attribute hierarchy are sorted based on the ASCII values of the member key. In this case, sorting by the
attribute name or key does not sort the commute distances from least to most. In this task, you sort the members of the attribute hierarchy
based on the CommuteDistanceSort named calculation that ascribes the appropriate sort number to each distinct value in the column. To
save time, this named calculation has already been added to the Customer table in the Adventure Works DW data source view. You can switch
to this data source view to view the SQL script that is used in this named calculation. For more information, see Defining Named Calculations in a
Data Source View (Analysis Services)6.

The following image shows the members of the Commute Distance attribute hierarchy, sorted by the ASCII values of the member key.

2. Switch to the Dimension Structure tab in Dimension Designer for the Customer dimension, right-click CommuteDistanceSort in the Customer
table in the Data Source View pane, and then click New Attribute from Column.

3. In the Attributes pane, select Commute Distance Sort, and then set the AttributeHierarchyEnabled property for this attribute to False in
the Properties window, set the AttributeHierarchyOptimizedState property to NotOptimized, and set the AttributeHierarchyOrdered
property to False.

These settings will hide the attribute from users and will improve processing time. This attribute will not be used for browsing. It will only be used
for ordering the members of another attribute.

4. Select Geography, and then set its AttributeHierarchyVisible property to False in the Properties window, set its
AttributeHierarchyOptimizedState property to NotOptimized, and set its AttributeHierarchyOrdered property to False.

These settings will hide the attribute from users and will improve processing time. This attribute will not be used for browsing. It will be only be
used for ordering the members of another attribute. Because Geography has member properties, its AttributeHierarchyEnabled property must
be set to True. Therefore, to hide the attribute, you set the AttributeHierarchyVisible property to False.

5. Click the Attribute Relationships tab.

6. In the attributes list, right-click the Commute Distance attribute and then select New Attribute Relationship.

7. In the Create Attribute Relationship dialog box, the Source Attribute is Commute Distance. Set the Related Attribute to Commute
Distance Sort.

8. In the Relationship type list, set the relationship type to Rigid.

The relationship between the members of the Commute Distance attribute and the Commute Distance Sort attribute will not change over
time.

9. Click OK.

You are now ready to set the sort order for the Commute Distance attribute.

10. Click the Dimension Structure tab.

11. In the Attributes pane, select Commute Distance, and then change the value of the OrderBy property in the Properties window to
AttributeKey, and change the value of the OrderByAttribute property to Commute Distance Sort.

12. On the Build menu, click Deploy Analysis Services Tutorial.

13. When deployment has successfully completed, switch to the Browser tab of Dimension Designer for the Customer dimension, click Reconnect,
and then browse the Commute Distance attribute hierarchy.

Notice that the attribute hierarchy members are now sorted in a logical order based on increasing distance, as shown in the following image.

Specifying Attribute Relationships Between Attributes in a User-Defined Hierarchy5
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Defining Attribute Relationships for Attributes in the Customer Geography Hierarchy

Specifying Attribute Relationships Between Attributes in a User-
Defined Hierarchy
SQL Server 2008 R2
As you have already learned in this tutorial, you can organize attribute hierarchies into levels within user hierarchies to provide navigation paths for users
in a cube. A user hierarchy can represent a natural hierarchy, such as city, state, and country, or can just represent a navigation path, such as
employee name, title, and department name. To the user navigating a hierarchy, these two types of user hierarchies are the same.

With a natural hierarchy, if you define attribute relationships between the attributes that make up the levels, Analysis Services can use an aggregation
from one attribute to obtain the results from a related attribute. If there are no defined relationships between attributes, Analysis Services will aggregate
all non-key attributes from the key attribute. Therefore, if the underlying data supports it, you should define attribute relationships between attributes.
Defining attribute relationships improves dimension, partition, and query processing performance. For more information, see Defining Attribute
Relationships1 and Attribute Relationships2.

When you define attribute relationships, you can specify that the relationship is either flexible or rigid. If you define a relationship as rigid, Analysis
Services retains aggregations when the dimension is updated. If a relationship that is defined as rigid actually changes, Analysis Services generates an
error during processing unless the dimension is fully processed. Specifying the appropriate relationships and relationship properties increases query and
processing performance. For more information, see Defining Attribute Relationships1, and User Hierarchy Properties3.

In the tasks in this topic, you define attribute relationships for the attributes in the natural user hierarchies in the Analysis Services Tutorial project.
These include the Customer Geography hierarchy in the Customer dimension, the Sales Territory hierarchy in the Sales Territory dimension, the
Product Model Lines hierarchy in the Product dimension, and the Fiscal Date and Calendar Date hierarchies in the Date dimension. These user
hierarchies are all natural hierarchies.

To define attribute relationships for attributes in the Customer Geography hierarchy

1. Switch to Dimension Designer for the Customer dimension, and then click the Dimension Structure tab.

In the Hierarchies pane, notice the levels in the Customer Geography user-defined hierarchy. This hierarchy is currently just a drill-down
path for users, as no relationship between levels or attributes have been defined.

2. Click the Attribute Relationships tab.

Notice the four attribute relationships that link the non-key attributes from the Geography table to the key attribute from the Geography
table. The Geography attribute is related to the Full Name attribute. The Postal Code attribute is indirectly linked to the Full Name attribute
through the Geography attribute, because the Postal Code is linked to the Geography attribute and the Geography attribute is linked to the
Full Name attribute. Next, we will change the attribute relationships so that they do not use the Geography attribute.

3. In the diagram, right-click the Full Name attribute and then select New Attribute Relationship.

4. In the Create Attribute Relationship dialog box, the Source Attribute is Full Name. Set the Related Attribute to Postal Code. In the
Relationship type list, leave the relationship type set to Flexible because relationships between the members might change over time.

5. Click OK.

A warning icon appears in the diagram because the relationship is redundant. The relationship Full Name -> Geography-> Postal Code already
existed, and you just created the relationship Full Name -> Postal Code. The relationship Geography-> Postal Code is now redundant, so we
will remove it.

6. In the Attribute Relationships pane, right-click Geography-> Postal Code and then click Delete.

7. When the Delete Objects dialog box appears, click OK.

8. In the diagram, right-click the Postal Code attribute and then select New Attribute Relationship.

9. In the Create Attribute Relationship dialog box, the Source Attribute is Postal Code. Set the Related Attribute to City. In the
Relationship type list, leave the relationship type set to Flexible.

10. Click OK.

The relationship Geography-> City is now redundant so we will delete it.

11. In the Attribute Relationships pane, right-click Geography-> City and then click Delete.

12. When the Delete Objects dialog box appears, click OK.

13. In the diagram, right-click the City attribute and then select New Attribute Relationship.

14. In the Create Attribute Relationship dialog box, the Source Attribute is City. Set the Related Attribute to State-Province. In the
Relationship type list, set the relationship type to Rigid because the relationship between a city and a state will not change over time.

15. Click OK.

16. Right-click the arrow between Geography and State-Province and then click Delete.

17. When the Delete Objects dialog box appears, click OK.

18. In the diagram, right-click the State-Province attribute and then select New Attribute Relationship.

19. In the Create Attribute Relationship dialog box, the Source Attribute is State-Province. Set the Related Attribute to Country-Region. In
the Relationship type list, set the relationship type to Rigid because the relationship between a state-province and a country-region will not
change over time.

20. Click OK.

21. In the Attribute Relationships pane, right-click Geography-> Country-Region and then click Delete.

22. When the Delete Objects dialog box appears, click OK.

23. Click the Dimension Structure tab.

24. In the Attributes pane, right-click the Geography attribute and click Delete.

This attribute is no longer needed.
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Defining Attribute Relationships for Attributes in the Sales Territory Hierarchy

Defining Attribute Relationships for Attributes in the Product M odel Lines Hierarchy

Defining Attribute Relationships for Attributes in the Fiscal Date Hierarchy

Defining Attribute Relationships for Attributes in the Calendar Date Hierarchy

Defining Attribute Relationships for Attributes in the Geography Hierarchy

25. When the Delete Objects dialog box appears, click OK.

26. On the File menu, click Save All.

To define attribute relationships for attributes in the Sales Territory hierarchy

1. Open Dimension Designer for the Sales Territory dimension, and then click the Attribute Relationships tab.

2. In the diagram, right-click the Sales Territory Country attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Sales Territory Country. Set the Related Attribute to Sales
Territory Group. In the Relationship type list, leave the relationship type set to Flexible.

4. Click OK.

Sales Territory Group is now linked to Sales Territory Country, and Sales Territory Country is now linked to Sales Territory Region. The
RelationshipType property for each of these relationships is set to Flexible because the groupings of regions within a country might change
over time and because the groupings of countries into groups might change over time.

To define attribute relationships for attributes in the Product Model Lines hierarchy

1. Open Dimension Designer for the Product dimension, and then click the Attribute Relationships tab.

2. In the diagram, right-click the Model Name attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Model Name. Set the Related Attribute to Product Line. In the
Relationship type list, leave the relationship type set to Flexible.

4. Click OK.

To define attribute relationships for attributes in the Fiscal Date hierarchy

1. Switch to Dimension Designer for the Date dimension, and then click the Attribute Relationships tab.

2. In the diagram, right-click the Month Name attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Month Name. Set the Related Attribute to Fiscal Quarter. In the
Relationship type list, set the relationship type to Rigid.

4. Click OK.

5. In the diagram, right-click the Fiscal Quarter attribute and then select New Attribute Relationship.

6. In the Create Attribute Relationship dialog box, the Source Attribute is Fiscal Quarter. Set the Related Attribute to Fiscal Semester. In
the Relationship type list, set the relationship type to Rigid.

7. Click OK.

8. In the diagram, right-click the Fiscal Semester attribute and then select New Attribute Relationship.

9. In the Create Attribute Relationship dialog box, the Source Attribute is Fiscal Semester. Set the Related Attribute to Fiscal Year. In the
Relationship type list, set the relationship type to Rigid.

10. Click OK.

To define attribute relationships for attributes in the Calendar Date hierarchy

1. In the diagram, right-click the Month Name attribute and then select New Attribute Relationship.

2. In the Create Attribute Relationship dialog box, the Source Attribute is Month Name. Set the Related Attribute to Calendar Quarter. In
the Relationship type list, set the relationship type to Rigid.

3. Click OK.

4. In the diagram, right-click the Calendar Quarter attribute and then select New Attribute Relationship.

5. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Quarter. Set the Related Attribute to Calendar
Semester. In the Relationship type list, set the relationship type to Rigid.

6. Click OK.

7. In the diagram, right-click the Calendar Semester attribute and then select New Attribute Relationship.

8. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Semester. Set the Related Attribute to Calendar Year.
In the Relationship type list, set the relationship type to Rigid.

9. Click OK.

To define attribute relationships for attributes in the Geography hierarchy

1. Open Dimension Designer for the Geography dimension, and then click the Attribute Relationships tab.

2. In the diagram, right-click the Postal Code attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Postal Code. Set the Related Attribute to City. In the
Relationship type list, set the relationship type to Flexible.

4. Click OK.

5. In the diagram, right-click the City attribute and then select New Attribute Relationship.
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6. In the Create Attribute Relationship dialog box, the Source Attribute is City. Set the Related Attribute to State-Province. In the
Relationship type list, set the relationship type to Rigid.

7. Click OK.

8. In the diagram, right-click the State-Province attribute and then select New Attribute Relationship.

9. In the Create Attribute Relationship dialog box, the Source Attribute is State-Province. Set the Related Attribute to Country-Region. In
the Relationship type list, set the relationship type to Rigid.

10. Click OK.

11. In the diagram, right-click the Geography Key attribute and then select Properties.

12. Set the AttributeHierarchyOptimizedState property to NotOptimized, set the AttributeHierarchyOrdered property to False, and set the
AttributeHierarchyVisible property to False.

13. On the File menu, click Save All.

14. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.
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Note

Reviewing Error Handling and Unknown Member Properties in the Product Dimension

Defining the Unknown Member and Null Processing Properties
SQL Server 2008 R2
When Analysis Services processes a dimension, all the distinct values from the underlying columns in the tables, or views in the data source view,
populate the attributes in the dimension. If Analysis Services encounters a null value during processing, by default, it converts this null to a zero for
numeric columns or to an empty string for string columns. You can modify the default settings or convert null values in your extract, transform, and load
process (if any) of the underlying relational data warehouse. Additionally, you can have Analysis Services convert the null value to a designated value by
configuring three properties: the UnknownMember and UnknownMemberName properties for the dimension, and the NullProcessing property for the
dimension's key attribute.

The Dimension Wizard and the Cube Wizard will enable these properties for you based on whether the key attribute of a dimension is nullable or the root
attribute of a snowflake dimension is based on a nullable column. In these cases, the NullProcessing property of the key attribute will be set to
UnknownMember and the UnknownMember property will be set to Visible.

However, when you build snowflaked dimensions incrementally, as we are doing with the Product dimension in this tutorial, or when you define dimensions
using Dimension Designer and then incorporate these existing dimensions into a cube, the UnknownMember and NullProcessing properties might need
to be set manually.

In the tasks in this topic, you will add the product category and product subcategory attributes to the Product dimension from snowflaked tables that
you will add to the Adventure Works DW data source view. You will then enable the UnknownMember property for the Product dimension, specify
Assembly Components as the value for the UnknownMemberName property, relate the Subcategory and Category attributes to the product name
attribute, and then define custom error handling for the member key attribute that links the snowflaked tables.

If you have added the Subcategory and Category attributes when you originally defined the Analysis Services Tutorial cube using the Cube Wizard,
these steps would have been performed for you automatically.

To review error handling and unknown member properties in the Product dimension

1. Switch to Dimension Designer for the Product dimension, click the Dimension Structure tab, and then select Product in the Attributes pane.

This enables you to view and modify the properties of the dimension itself.

2. In the Properties window, review the UnknownMember and UnknownMemberName properties.

Notice that the UnknownMember property is not enabled, because its value is set to None instead of Visible or Hidden, and that no name is
specified for the UnknownMemberName property.

3. In the Properties window, select (custom) in the ErrorConfiguration property cell, and then expand the ErrorConfiguration properties
collection.

Setting the ErrorConfiguration property to (custom) allows you to view the default error configuration settings - it does not change any
settings.

4. Review the key and null key error configuration properties, but do not make any changes.

Notice that, by default, when null keys are converted to the unknown member and the processing error associated with this conversion is
ignored.

The following image shows the property settings for the ErrorConfiguration properties collection.

5. Click the Browser tab, verify that Product Model Lines is selected in the Hierarchy list, and then expand All Products.

Notice the five members of the Product Line level.

6. Expand Components, and then expand the unlabeled member of the Model Name level.

This level contains the assembly components that are used when building other components, starting with the Adjustable Race product, as
shown in the following image.
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Defining Attributes from Snowflaked Tables and a Product Category User-Defined Hierarchy

Browsing the User-Defined Hierarchies in the Product Dimension

To define attributes from snowflaked tables and a Product Category user-defined hierarchy

1. Open Data Source View Designer for the Adventure Works DW data source view, select Reseller Sales in the Diagram Organizer pane, and
then click Add/Remove Tables on the Data Source View menu of Business Intelligence Development Studio.

The Add/Remove Tables dialog box opens.

2. In the Included objects list, select dbo.DimProduct, and then click Add Related Tables.

The dbo.DimProductSubcategory table is added to the Included objects list.

3. With the dbo.DimProductSubcategory table selected by default as the table most recently added, click Add Related Tables again.

The dbo.DimProductCategory table is added to the Included objects list.

4. Click OK.

5. On the Format menu of BI Development Studio, point to Auto Layout, and then click Diagram.

Notice that the dbo.DimProductSubcategory table and dbo.DimProductCategory table are linked to each other, and also to the
ResellerSales table through the Product table.

6. Switch to Dimension Designer for the Product dimension, and then click the Dimension Structure tab.

7. Right-click anywhere in the Data Source View pane, and then click Show All Tables.

8. In the Data Source View pane, locate the DimProductCategory table, right-click ProductCategoryKey in that table, and then click New
Attribute from Column.

9. In the Attributes pane, change the name of this new attribute to Category.

10. In the Properties window, click in the NameColumn property field and then click the browse («) button to open the Name Column dialog box.

11. Select EnglishProductCategoryName in the Source column list and then click OK.

12. In the Data Source View pane, locate the DimProductSubcategory table, right-click ProductSubcategoryKey in that table, and then click
New Attribute from Column.

13. In the Attributes pane, change the name of this new attribute to Subcategory.

14. In the Properties window, click in the NameColumn property field and then click the browse �«� button to open the Name Column dialog box.

15. Select EnglishProductSubcategoryName in the Source column list and then click OK.

16. Create a new user-defined hierarchy called Product Categories with the following levels, in order from top to bottom: Category,
Subcategory, and Product Name.

17. Specify All Products as the value for the AllMemberName property of the Product Categories user-defined hierarchy.

To browse the user-defined hierarchies in the Product dimension

1. On the toolbar of the Dimension Structure tab of Dimension Designer for the Product dimension, click Process.

2. Click Yes to build and deploy the project, and then click Run to process the Product dimension.

3. When processing has succeeded, expand Processing Dimension 'Product' completed successfully in the Process Progress dialog box,
expand Processing Dimension Attribute 'Product Name' completed successfully, and then expand SQL queries 1.

4. Click the SELECT DISTINCT query and then click View Details.

Notice that a WHERE clause has been added to the SELECT DISTINCT clause that removes those products that have no value in the
ProductSubcategoryKey column, as shown in the following image.
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Enabling the Unknown Member, Defining Attribute Relationships, and Specifying Custom Processing Prope
rties for Nulls

5. Click Close three times to close all processing dialog boxes.

6. Click the Browser tab in Dimension Designer for the Product dimension, and then click Reconnect.

7. Verify that Product Model Lines appears in the Hierarchy list, expand All Products, and then expand Components.

Notice that all the list of assembly components are missing because of the WHERE clause in the SELECT DISTINCT statement, as shown in the
following image.

8. Select Product Categories in the Hierarchy list, expand All Products, and then expand Components.

Notice that none of the assembly components appear.

To modify the behavior mentioned in the previous task, you will enable the UnknownMember property of the Products dimension, set a value for the
UnknownMemberName property, set the NullProcessing property for the Subcategory and Model Name attributes to UnknownMember, define
the Category attribute as a related attribute of the Subcategory attribute, and then define the Product Line attribute as a related attribute of the
Model Name attribute. These steps will cause Analysis Services to use the unknown member name value for each product that does not have a value
for the SubcategoryKey column, as you will see in the following task.

To enable the unknown member, define attribute relationships, and specify custom processing properties for nulls

1. Click the Dimension Structure tab in Dimension Designer for the Product dimension, and then select Product in the Attributes pane.

2. In the Properties window, change the UnknownMember property to Visible, and then change the value for the UnknownMemberName
property to Assembly Components.

Changing the UnknownMember property to either Visible or Hidden enables the UnknownMember property for the dimension.

3. Click the Attribute Relationships tab.

4. In the diagram, right-click the Subcategory attribute and then select New Attribute Relationship.

5. In the Create Attribute Relationship dialog box, the Source Attribute is Subcategory. Set the Related Attribute to Category. Leave the
relationship type set to Flexible.

6. Click OK.

7. In the Attributes pane, select Subcategory.

8. In the Properties window, expand the KeyColumns property and then expand the DimProductSubcategory.ProductSubcategoryKey
(Integer) property.

9. Change the NullProcessing property to UnknownMember.

10. In the Attributes pane, select Model Name.

11. In the Properties window, expand the KeyColumns property and then expand the Product.ModelName (WChar) property.

12. Change the NullProcessing property to UnknownMember.

Because of these changes, when Analysis Services encounters a null value for the Subcategory attribute or the Model Name attribute during
processing, the unknown member value will be substituted as the key value, and the user-defined hierarchies will be constructed correctly.
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To browse the Product dimension

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab in Dimension Designer for the Product dimension, and then click
Reconnect.

3. Verify that Product Categories is selected in the Hierarchy list, and then expand All Products.

Notice that Assembly Components appears as a new member of the Category level.

4. Expand the Assembly Components member of the Category level and then expand the Assembly Components member of the Subcategory
level.

Notice that all the assembly components now appear at the Product Name level, as shown in the following image.

5. Select Product Model Lines in the Hierarchy list, expand All Products, expand the Assembly Components member of the Product Line
level, and then expand the Assembly Components member of the Model Name level.

Notice that all the assembly components now appear at the Product Name level.

Lesson 5: Defining Relationships Between Dimensions and Measure Groups1

Links Table

1http://technet.microsoft.com/en-us/library/ms166560(v=sql.105).aspx

javascript:void(0)
javascript:void(0)
http://technet.microsoft.com/en-us/library/ms166560(v=sql.105).aspx
http://technet.microsoft.com/en-us/cc300389
http://www.microsoft.com/library/toolbar/3.0/trademarks/en-us.mspx
http://www.microsoft.com/info/privacy.mspx
http://social.msdn.microsoft.com/Forums/en-US/libraryfeedback/threads


Note

Next Lesson

See Also

�������0LFURVRIW��$OO�ULJKWV�UHVHUYHG�

Lesson 5: Defining Relationships Between Dimensions and
Measure Groups
SQL Server 2008 R2
In the previous lessons in this tutorial, you learned that database dimensions added to a cube can be used as the basis for one or more cube dimensions.
In this lesson, you learn to define different types of relationships between cube dimensions and measure groups, and to specify the properties of these
relationships.

For more information, see Dimension Relationships1 and Defining Dimension Usage Relationships2.

A completed project through Lesson 4 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases3.

This lesson contains the following tasks:

Defining a Referenced Relationship4

,Q�WKLV�WDVN��\RX�OHDUQ�WR�OLQN�D�GLPHQVLRQ�WR�D�IDFW�WDEOH�LQGLUHFWO\�WKURXJK�D�GLPHQVLRQ�WKDW�LV�OLQNHG�GLUHFWO\�WKURXJK�D�SULPDU\�NH\±IRUHLJQ�NH\
relationship. Related topic: Defining a Referenced Relationship and Referenced Relationship Properties5

Defining a Fact Relationship6

In this task, you learn to define a dimension based on data in the fact table, and to define the dimension relationship as a fact relationship.
Related topic: Defining a Fact Relationship and Fact Relationship Properties7

Defining a Many-to-Many Relationship8

In this task, you learn to relate a fact to multiple dimension members through the definition of a many-to-many relationship between dimension
tables and fact tables. Related topic: Defining a Many-to-Many Relationship and Many-to-Many Relationship Properties9

Defining Dimension Granularity within a Measure Group10

In this task, you learn to modify the granularity of a dimension for a specific measure group. Related topic: Defining a Regular Relationship and
Regular Relationship Properties11

Lesson 6: Defining Calculations12

Concepts

Analysis Services Tutorial Scenario13

SQL Server Analysis Services Tutorial14

Dimension Relationships1

Defining Dimension Usage Relationships2

Links Table

1http://technet.microsoft.com/en-us/library/ms175669(v=sql.105).aspx

2http://technet.microsoft.com/en-us/library/ms365387(v=sql.105).aspx

3http://technet.microsoft.com/en-us/library/ms161556(v=sql.105).aspx

4http://technet.microsoft.com/en-us/library/ms166704(v=sql.105).aspx

5http://technet.microsoft.com/en-us/library/ms365365(v=sql.105).aspx

6http://technet.microsoft.com/en-us/library/ms167409(v=sql.105).aspx

7http://technet.microsoft.com/en-us/library/ms365400(v=sql.105).aspx

8http://technet.microsoft.com/en-us/library/ms170463(v=sql.105).aspx

9http://technet.microsoft.com/en-us/library/ms365407(v=sql.105).aspx

10http://technet.microsoft.com/en-us/library/ms166573(v=sql.105).aspx

11http://technet.microsoft.com/en-us/library/ms365371(v=sql.105).aspx

12http://technet.microsoft.com/en-us/library/ms169748(v=sql.105).aspx

13http://technet.microsoft.com/en-us/library/ms166713(v=sql.105).aspx

14http://technet.microsoft.com/en-us/library/ms170208(v=sql.105).aspx
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Dimensioning Reseller Sales by Geography

Defining a Referenced Relationship
SQL Server 2008 R2
Up to this point in the tutorial, each cube dimension that you defined was based on a table that was directly linked to the fact table for a measure group
by a primary key to foreign key relationship. In the tasks in this topic, you link the Geography dimension to the fact table for reseller sales through the
Reseller dimension, which is called a reference dimension. This enables users to dimension reseller sales by geography. For more information, see
Defining a Referenced Relationship and Referenced Relationship Properties1.

To dimension Reseller Sales by Geography

1. In Solution Explorer, right-click Analysis Services Tutorial in the Cubes folder, and then click Browse.

2. Remove all hierarchies from the data pane, and then verify that the Reseller Sales-Sales Amount measure appears in the data area of the
data pane. Add it to the data pane if it is not already there.

3. From the Geography dimension in the metadata pane, drag the Geographies user-defined hierarchy to the Drop Row Fields Here area of the
data pane.

Notice that the Reseller Sales-Sales Amount measure is not correctly dimensioned by the Country-Region attribute members in the Regions
hierarchy, as shown in the following image.

4. Open Data Source View Designer for the Adventure Works DW data source view.

5. In the Diagram Organizer pane, view the relationship between the Geography table and the ResellerSales table.

Notice that there is no direct link between these tables. However, there is an indirect link between these tables through either the Reseller
table or the SalesTerritory table.

6. 'RXEOH�FOLFN�WKH�DUURZ�WKDW�UHSUHVHQWV�WKH�IRUHLJQ�NH\±SULPDU\�NH\�UHODWLRQVKLS�EHWZHHQ�WKH�Geography table and the Reseller table.

In the Edit Relationship dialog box, notice that the GeographyKey column is the primary key in the Geography table and the foreign key in
the Reseller table.

7. Click Cancel, switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Dimension Usage tab.

Notice that the Geography cube dimension does not currently have a relationship with either the Internet Sales measure group or the
Reseller Sales measure group.

8. Click the ellipsis button («) in the Full Name cell at the intersection of the Customer dimension and the Internet Sales measure group.

In the Define Relationship dialog box, notice that a Regular relationship is defined between the DimCustomer dimension table and the
FactInternetSales measure group table based on the CustomerKey column in each of these tables. All the relationships that you have defined
within this tutorial up to this point have been regular relationships.

The following image shows the Define Relationship dialog box with a regular relationship between the DimCustomer dimension table and the
FactInternetSales measure group table.
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Defining the Intermediate Dimension Attribute and the Referenced Dimension Relationship

9. Click Cancel.

10. Click the ellipsis button («) in the unnamed cell at the intersection of the Geography dimension and the Reseller Sales measure group.

In the Define Relationship dialog box, notice that no relationship is currently defined between the Geography cube dimension and the Reseller
Sales measure group. You cannot define a regular relationship because there is no direct relationship between the dimension table for the
Geography dimension and the fact table for the Reseller Sales measure group.

11. In the Select relationship type list, select Referenced.

You define a referenced relationship by specifying a dimension that is directly connected to the measure group table, called an intermediate
dimension, that Analysis Services can use to link the reference dimension to the fact table. You then specify the attribute that links the
reference dimension to the intermediate dimension.

12. In the Intermediate dimension list, select Reseller.

The underlying table for the Geography dimension is linked to the fact table through the underlying table for the Reseller dimension.

13. In the Reference dimension attribute list, select Geography Key, and then try to select Geography Key in the Intermediate dimension
attribute list.

Notice that Geography Key does not appear in the Intermediate dimension attribute list. This is because the GeographyKey column is not
defined as an attribute in the Reseller dimension.

The following image shows that Geography Key is not available as an intermediate dimension attribute in the Define Relationship dialog box for
the Reseller intermediate dimension.

14. Click Cancel.

In the next task, you will solve this problem by defining an attribute that is based on the GeographyKey column in the Reseller dimension.

To define the intermediate dimension attribute and the referenced dimension relationship

1. Open Dimension Designer for the Reseller dimension, and view the columns in the Reseller table in the Data Source View pane, and view the
defined attributes in the Reseller dimension in the Attributes pane.

Notice that although GeographyKey is defined as a column in the Reseller table, no dimension attribute is defined in the Reseller dimension based
on this column. Geography is defined as a dimension attribute in the Geography dimension because it is the key column that links the underlying
table for that dimension to the fact table.

2. To add a Geography Key attribute to the Reseller dimension, right-click GeographyKey in the Data Source View pane, and then click New
Attribute from Column.

3. In the Attributes pane, select Geography Key, and then, in the Properties window, set the AttributeHierarchyOptimizedState property to
NotOptimized, the AttributeHierarchyOrdered property to False, and the AttributeHierarchyVisible property to False.

The Geography Key attribute in the Reseller dimension will only be used to link the Geography dimension to the Reseller Sales fact table. Because
it will not be used for browsing, there is no value in defining this attribute hierarchy as visible. Additionally, ordering and optimizing the attribute
hierarchy will only negatively affect processing performance. However, the attribute must be enabled to serve as the link between the two
dimensions.

4. Switch to Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab, and then click the ellipsis button («) at the
intersection of the Reseller Sales measure group and the Geography cube dimension.

5. In the Select relationship type list, select Referenced.

6. In the Intermediate dimension list, select Reseller.

7. In the Reference dimension attribute list, select Geography Key, and then select Geography Key in the Intermediate dimension
attribute list.

Notice that the Materialize check box is selected. This is the default setting for MOLAP dimensions. Materializing the dimension attribute link
causes the value of the link between the fact table and the reference dimension for each row to be materialized, or stored, in the dimension's
MOLAP structure during processing. This will have a minor effect on processing performance and storage requirements, but will increase query
performance (sometimes significantly).
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8. Click OK.

Notice that the Geography cube dimension is now linked to the Reseller Sales measure group. The icon indicates that the relationship is a
referenced dimension relationship.

9. In the Dimensions list on the Dimension Usage tab, right-click Geography, and then click Rename.

10. Change the name of this cube dimension to Reseller Geography.

Because this cube dimension is now linked to the Reseller Sales measure group, users will benefit from explicitly defining its use in the cube, to
avoid possible user confusion.

To dimension Reseller Sales by Geography

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the
Reconnect button.

3. In the metadata pane, expand Reseller Geography, right-click Geographies, and then click Add to Row Area.

Notice that the Reseller Sales-Sales Amount measure is now correctly dimensioned by the Country-Region attribute of the Geographies
user-defined hierarchy, as shown in the following image.

Defining a Fact Relationship2

Concepts

Attribute Relationships3

Defining a Referenced Relationship and Referenced Relationship Properties1

Links Table

1http://technet.microsoft.com/en-us/library/ms365365(v=sql.105).aspx
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Note

Defining the Internet Sales Orders Fact Dimension

Defining a Fact Relationship for the Fact Dimension

Defining a Fact Relationship
SQL Server 2008 R2
Users sometimes want to be able to dimension measures by data items that are in the fact table or to query the fact table for specific additional related
information, such as invoice numbers or purchase order numbers related to specific sales facts. When you define a dimension based on such a fact table
item, the dimension is called a fact dimension. Fact dimensions are also known as degenerate dimensions. Fact dimensions are useful for grouping
together related fact table rows, such as all the rows that are related to a particular invoice number. Although you can put this information in a separate
dimension table in the relational database, creating a separate dimension table for the information provides no benefit because the dimension table would
grow at the same rate as the fact table, and would just create duplicate data and unnecessary complexity.

Within Analysis Services, you can determine whether to duplicate the fact dimension data in a MOLAP dimension structure for increased query
performance, or whether to define the fact dimension as a ROLAP dimension to save storage space at the expense of query performance. When you
store a dimension with the MOLAP storage mode, all the dimension members are stored in the instance of Analysis Services in a highly compressed MOLAP
structure, in addition to being stored in the measure group's partitions. When you store a dimension with the ROLAP storage mode, only the dimension
GHILQLWLRQ�LV�VWRUHG�LQ�WKH�02/$3�VWUXFWXUH²WKH�GLPHQVLRQ�PHPEHUV�WKHPVHOYHV�DUH�TXHULHG�IURP�WKH�XQGHUO\LQJ�UHODWLRQDO�IDFW�WDEOH�DW�TXHU\�WLPH��<RX
decide the appropriate storage mode based on how frequently the fact dimension is queried, the number of rows returned by a typical query, the
performance of the query, and the processing cost. Defining a dimension as ROLAP does not require that all cubes that use the dimension also be stored
with the ROLAP storage mode. This is different from SQL Server 2000 Analysis Services.

When you define a fact dimension, you can define the relationship between the fact dimension and the measure group as a fact relationship. The
following constraints apply to fact relationships:

The granularity attribute must be the key column for the dimension, which creates a one-to-one relationship between the dimension and the facts
in the fact table.

A dimension can have a fact relationship with only a single measure group.

Fact dimensions must be incrementally updated after every update to the measure group that the fact relationship references.

For more information, see Dimension Relationships1, and Defining a Fact Relationship and Fact Relationship Properties2.

In the tasks in this topic, you add a new cube dimension based on the CustomerPONumber column in the FactInternetSales fact table. You then
define the relationship between this new cube dimension and the Internet Sales measure group as a fact relationship.

To define the Internet Sales Orders fact dimension

1. In Solution Explorer, right-click Dimensions, and then click New Dimension.

2. On the Welcome to the Dimension Wizard page, click Next.

3. On the Select Creation Method page, verify that the Use an existing table option is selected, and then click Next.

4. On the Specify Source Information page, verify that the Adventure Works DW data source view is selected.

5. In the Main table list, select InternetSales.

6. In the Key columns list, verify that SalesOrderNumber and SalesOrderLineNumber are listed.

7. In the Name column list, select SalesOrderLineNumber.

8. Click Next.

9. On the Select Related Tables page, clear the check boxes beside all of the tables, and then click Next.

10. On the Select Dimension Attributes page, click the check box in the header twice to clear all of the check boxes. The Sales Order Number
attribute will remain selected because it is the key attribute.

11. Select the Customer PO Number attribute, and then click Next.

12. On the Completing the Wizard page, change the name to Internet Sales Order Details and then click Finish to complete the wizard.

13. On the File menu, click Save All.

14. In the Attributes pane of the Dimension Designer for the Internet Sales Order Details dimension, select Sales Order Number, and then
change the Name property in the Properties window to Item Description.

15. In the NameColumn property cell, click the browse button �«�. In the Name Column dialog box, select Product from the Source table list,
select EnglishProductName for the Source column, and then click OK.

16. Add the Sales Order Number attribute to the dimension by dragging the SalesOrderNumber column from the InternetSales table in the Data
Source View pane to the Attributes pane.

17. Change the Name property of the new Sales Order Number attribute to Order Number, and change the OrderBy property to Key.

18. In the Hierarchies pane, create an Internet Sales Orders user hierarchy that contains the Order Number and Item Description levels, in
that order.

19. In the Attributes pane, select Internet Sales Order Details, and then review the value for the StorageMode property in the Properties
window.

Notice that, by default, this dimension is stored as a MOLAP dimension. Although changing the storage mode to ROLAP will save processing time
and storage space, it occurs at the expense of query performance. For the purposes of this tutorial, you will use MOLAP as the storage mode.

20. To add the newly created dimension to the Analysis Services Tutorial cube as a cube dimension, switch to Cube Designer. On the Cube
Structure tab, right-click in the Dimensions pane and select Add Cube Dimension.

21. In the Add Cube Dimension.dialog box, select Internet Sales Order Details and then click OK.
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To define a fact relationship for the Fact dimension

1. In the Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab.

Notice that the Internet Sales Order Details cube dimension is automatically configured as having a fact relationship, as shown by the unique
icon.

2. Click the browse button («) in the Item Description cell, at the intersection of the Internet Sales measure group and the Internet Sales
Order Details dimension, to review the fact relationship properties.

The Define Relationship dialog box opens. Notice that you cannot configure any of the properties.

The following image shows the fact relationship properties in the Define Relationship dialog box.

3. Click Cancel.

To browse the cube by using the Fact D imension

1. On the Build menu, click Deploy Analysis Services Tutorial to deploy the changes to the instance of Analysis Services and process the
database.

2. After deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the
Reconnect button.

3. Clear all measures and hierarchies from the data pane, and then add the Internet Sales-Sales Amount measure to the data area of the data
pane.

4. In the metadata pane, expand Customer, expand Location, expand Customer Geography, expand Members, expand All Customers, expand
Australia, expand Queensland, expand Brisbane, expand 4000, right-click Adam Powell, and then click Add to Subcube Area.

Filtering to limit the sales orders returned to a single customer lets the user drill down to the underlying detail in a large fact table without
suffering a significant loss in query performance.

5. Add the Internet Sales Orders user-defined hierarchy from the Internet Sales Order Details dimension to the row area of the data pane.

Notice that the sales order numbers and the corresponding Internet sales amounts for Adam Powell appear in the data pane.

6. Expand each sales order number in the row area to view the details of each line item in those orders.

The following image shows the result of the previous steps.

Defining a Many-to-Many Relationship3
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Defining a Fact Relationship and Fact Relationship Properties2
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Note

Adding Required Tables to the Data Source View

Defining a Many-to-Many Relationship
SQL Server 2008 R2
When you define a dimension, typically each fact joins to one and only one dimension member, whereas a single dimension member can be associated
with many different facts. For example, each customer can have many orders but each order belongs to a single customer. In relational database
terminology, this is referred to as a one-to-many relationship. However, sometimes a single fact can join to multiple dimension members. In relational
database terminology, this is referred to as a many-to-many relationship. For example, a customer may have multiple reasons for making a purchase, and
a purchase reason can be associated with multiple purchases. A join table is used to define the sales reasons that relate to each purchase. A Sales
Reason dimension constructed from such relationships would then have multiple members that relate to a single sales transaction. Many-to-many
dimensions expand the dimensional model beyond the classic star schema and support complex analytics when dimensions are not directly related to a
fact table.

In Analysis Services, you define a many-to-many relationship between a dimension and a measure group by specifying an intermediate fact table that is
joined to the dimension table. An intermediate fact table is joined, in turn, to an intermediate dimension table to which the fact table is joined. The
many-to-many relationships between the intermediate fact table and both the dimension tables in the relationship and the intermediate dimension
creates the many-to-many relationships between members of the primary dimension and measures in the measure group that is specified by the
relationship. In order to define a many-to-many relationship between a dimension and a measure group through an intermediate measure group, the
intermediate measure group must share one or more dimensions with the original measure group.

With a many-to-many dimension, values are distinct summed, which means that they do not aggregate more than once to the All member.

,Q�RUGHU�WR�VXSSRUW�D�PDQ\�WR�PDQ\�GLPHQVLRQ�UHODWLRQVKLS��D�SULPDU\�NH\±IRUHLJQ�NH\�UHODWLRQVKLS�PXVW�EH�GHILQHG�LQ�WKH�GDWD�VRXUFH�YLHZ�EHWZHHQ
all the tables that are involved. Otherwise, you will not be able to select the correct intermediate measure group when you establish the relationship
in the Dimension Usage tab of Cube Designer.

For more information, see Dimension Relationships1, and Defining a Many-to-Many Relationship and Many-to-Many Relationship Properties2.

In the tasks in this topic, you define the Sales Reasons dimension and the Sales Reasons measure group, and you define a many-to-many relationship
between the Sales Reasons dimension and the Internet Sales measure group through the Sales Reasons measure group.

To add required tables to the data source view

1. Open Data Source View Designer for the Adventure Works DW data source view.

2. Right-click anywhere in the Diagram Organizer pane, click New Diagram, and specify Internet Sales Order Reasons as the name for this
new diagram. For more information, see Working with Diagrams in a Data Source View (Analysis Services)3.

3. Drag the InternetSales table to the Diagram pane from the Tables pane.

4. Right-click anywhere in the Diagram pane, and then click Add/Remove Tables.

5. In the Add/Remove Tables dialog box, add the DimSalesReason table and the FactInternetSalesReason table to the Included objects
list, and then click OK.

1RWLFH�WKDW�WKH�SULPDU\�NH\±IRUHLJQ�NH\�UHODWLRQVKLSV�EHWZHHQ�WKH�WDEOHV�WKDW�DUH�LQYROYHG�DUH�HVWDEOLVKHG�DXWRPDWLFDOO\�EHFDXVH�WKRVH
relationships are defined in the underlying relational database. If these relationships were not defined in the underlying relational database, you
would have to define them in the data source view.

6. On the Format menu, point to Auto Layout, and then click Diagram.

7. In the Properties window, change the FriendlyName property of the DimSalesReason table to SalesReason, and then change the
FriendlyName property of the FactInternetSalesReason table to InternetSalesReason.

8. In the Tables pane, expand InternetSalesReason (dbo.FactInternetSalesReason), click SalesOrderNumber, and then review the
DataType property for this data column in the Properties window.

Notice that the data type for the SalesOrderNumber column is a string data type.

9. Review the data types for the other columns in the InternetSalesReason table.

Notice that the data types for the other two columns in this table are numeric data types.

10. In the Tables pane, right-click InternetSalesReason (dbo.FactInternetSalesReason), and then click Explore Data.

Notice that, for each line number within each order, a key value identifies the sales reason for the purchase of that line item, as shown in the
following image.
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Defining the Intermediate Measure Group

Defining the Many-to- Many Dimension

To define the intermediate measure group

1. Switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Cube Structure tab.

2. Right-click anywhere in the Measures pane, and then click New Measure Group. For more information, see Defining Measure Groups4.

3. In the New Measure Group dialog box, select InternetSalesReason in the Select a table from the data source view list, and then click OK.

Notice that the Internet Sales Reason measure group now appears in the Measures pane.

4. Expand the Internet Sales Reason measure group.

Notice that only a single measure is defined for this new measure group, the Internet Sales Reason Count measure.

5. Select Internet Sales Reason Count and review the properties of this measure in the Properties window.

Notice that the AggregateFunction property for this measure is defined as Count instead of Sum. Analysis Services chose Count because the
underlying data type is a string data type. The other two columns in the underlying fact table were not selected as measures because Analysis
Services detected them as numeric keys instead of as actual measures. For more information, see Defining Semiadditive Behavior5.

6. In the Properties window, change the Visible property of the Internet Sales Reason Count measure to False.

This measure will only be used to join the Sales Reason dimension that you will define next to the Internet Sales measure group. Users will not
browse this measure directly.

The following image shows the properties for the Internet Sales Reason Count measure.

To define the many-to-many d imension

1. In Solution Explorer, right-click Dimensions, and then click New Dimension.

2. On the Welcome to the Dimension Wizard page, click Next.

3. On the Select Creation Method page, verify that the Use an existing table option is selected, and then click Next.

4. On the Specify Source Information page, verify that the Adventure Works DW data source view is selected.

5. In the Main table list, select SalesReason.

6. In the Key columns list, verify that SalesReasonKey is listed.

7. In the Name column list, select SalesReasonName.

8. Click Next.

9. On the Select Dimension Attributes page, the Sales Reason Key attribute is automatically selected because it is the key attribute. Select
the check box beside the Sales Reason Reason Type attribute, change its name to Sales Reason Type, and then click Next.

10. On the Completing the Wizard page, click Finish to create the Sales Reason dimension.

11. On the File menu, click Save All.

12. In the Attributes pane of the Dimension Designer for the Sales Reason dimension, select Sales Reason Key, and then change the Name
property in the Properties window to Sales Reason.

13. In the Hierarchies pane of the Dimension Designer, create a Sales Reasons user hierarchy that contains the Sales Reason Type level and the
Sales Reason level, in that order.

14. In the Properties window, define All Sales Reasons as the value for the AllMemberName property of the Sales Reasons hierarchy.

15. Define All Sales Reasons as the value for AttributeAllMemberName property of the Sales Reason dimension.
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Defining the Many to Many Relationship

Browsing the Cube and the Many-to- Many Dimension

16. To add the newly created dimension to the Analysis Services Tutorial cube as a cube dimension, switch to Cube Designer. On the Cube
Structure tab, right-click in the Dimensions pane and select Add Cube Dimension.

17. In the Add Cube Dimension dialog box, select Sales Reason and then click OK.

18. On the File menu, click Save All.

To define the many-to-many relationship

1. Switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Dimension Usage tab.

Notice that the Sales Reason dimension has a regular relationship defined with the Internet Sales Reason measure group, but has no
relationship defined with the Internet Sales or Reseller Sales measure groups. Notice also that the Internet Sales Order Details dimension
has a regular relationship defined with the Internet Sales Reason dimension, which in turn has a Fact Relationship with the Internet Sales
measure group. If this dimension was not present (or another dimension with a relationship with both the Internet Sales Reason and the
Internet Sales measure group were not present), you would not be able to define the many-to-many relationship.

2. Click the cell at the intersection of the Internet Sales measure group and the Sales Reason dimension and then click the browse button (...).

3. In the Define Relationship dialog box, select Many-to-Many in the Select relationship type list.

You have to define the intermediate measure group that connects the Sales Reason dimension to the Internet Sales measure group.

4. In the Intermediate measure group list, select Internet Sales Reason.

The following image shows the changes in the Define Relationship dialog box.

5. Click OK.

Notice the many-to-many icon that represents the relationship between the Sales Reason dimension and the Internet Sales measure group.

Browsing the cube and the Many-to-Many D imension

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then
click Reconnect.

3. Clear all measures and hierarchies from the data pane.

4. Add the Internet Sales-Sales Amount measure to the data area of the data pane.

5. Add the Sales Reasons user-defined hierarchy from the Sales Reason dimension to the row area of the data pane.

6. In the metadata pane, expand Customer, expand Location, expand Customer Geography, expand Members, expand All Customers, expand
Australia, right-click Queensland, and then click Add to Subcube Area.

7. Expand each member of the Sales Reason Type level to review the dollar values that are associated with each reason a customer in
Queensland gave for their purchase of an Adventure Works product over the Internet.

Notice that the totals that are associated with each sales reason add up to more than the total sales. This is because some customers cited
multiple reasons for their purchase.

The following image shows the Filter pane and Data pane of Cube Designer.
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Adding Tables and Defining the Sales Quotas Measure Group

Browsing the Measures in the Sales Quota Measure Group by Date

Defining Dimension Granularity within a Measure Group
SQL Server 2008 R2
Users will want to dimension fact data at different granularity or specificity for different purposes. For example, sales data for reseller or internet sales
may be recorded for each day, whereas sales quota information may only exist at the month or quarter level. In these scenarios, users will want a time
dimension with a different grain or level of detail for each of these different fact tables. While you could define a new database dimension as a time
dimension with this different grain, there is an easier way with Analysis Services.

By default in Analysis Services, when a dimension is used within a measure group, the grain of the data within that dimension is based on the key
attribute of the dimension. For example, when a time dimension is included within a measure group and the default grain of the time dimension is daily,
the default grain of that dimension within the measure group is daily. Many times this is appropriate, such as for the Internet Sales and Reseller Sales
measure groups in this tutorial. However, when such a dimension is included in other types of measure groups, such as in a sales quota or budget
measure group, a monthly or quarterly grain is generally more appropriate.

To specify a grain for a cube dimension other than the default grain, you modify the granularity attribute for a cube dimension as used within a particular
measure group on the Dimension Usage tab of Cube Designer. When you change the grain of a dimension within a specific measure group to an
attribute other than the key attribute for that dimension, you must guarantee that all other attributes in the measure group are directly or indirectly
related to new granularity attribute. You do this by specifying attribute relationships between all other attributes and the attribute that is specified as
the granularity attribute in the measure group. In this case, you define additional attribute relationships rather than move attribute relationships. The
attribute that is specified as the granularity attribute effectively becomes the key attribute within the measure group for the remaining attributes in the
dimension. If you do not specify attribute relationships appropriately, Analysis Services will not be able to aggregate values correctly, as you will see in
the tasks in this topic.

For more information, see Dimension Relationships1, Defining a Regular Relationship and Regular Relationship Properties2.

In the tasks in this topic, you add a Sales Quotas measure group and define the granularity of the Date dimension in this measure group to be monthly.
You then define attribute relationships between the month attribute and other dimension attributes to ensure that Analysis Services aggregates values
correctly.

To add tables and define the Sales Quotas measure group

1. Switch to Data Source View Designer for the Adventure Works DW data source view.

2. Right-click anywhere in the Diagram Organizer pane, click New Diagram, and then specify Sales Quotas as the name for the new diagram.
For more information, see Working with Diagrams in a Data Source View (Analysis Services)3.

3. Drag the Employee, Sales Territory, and Date tables from the Tables pane to the Diagram pane.

4. Add the FactSalesQuota table to the Diagram pane by right-clicking anywhere in the Diagram pane and selecting Add/Remove Tables.

Notice that the SalesTerritory table is linked to the FactSalesQuota table through the Employee table.

5. Review the columns in the FactSalesQuota table and then explore the data in this table.

Notice that the grain of the data within this table is the calendar quarter, which is the lowest level of detail in the FactSalesQuota table.

6. In Data Source View Designer, change the FriendlyName property of the FactSalesQuota table to SalesQuotas.

7. Switch to Cube Designer for the Analysis Services Tutorial cube, and then click the Cube Structure tab.

8. Right-click anywhere in the Measures pane, click New Measure Group, click SalesQuotas in the New Measure Group dialog box, and then
click OK.

The Sales Quotas measure group appears in the Measures pane. In the Dimensions pane, notice that a new Date cube dimension is also
defined, based on the Date database dimension. A new time-related cube dimension is defined because Analysis Services does not know which
of the existing time-related cube dimensions to relate to the DateKey column in the FactSalesQuota fact table that underlies the Sales Quotas
measure group. You will change this later in another task in this topic.

9. Expand the Sales Quotas measure group.

10. In the Measures pane, select Sales Amount Quota, and then set the value for the FormatString property to Currency in the Properties
window.

11. Select the Sales Quotas Count measure, and then type #,# as the value for the FormatString property in the Properties window.

12. Delete the Calendar Quarter measure from the Sales Quotas measure group.

Analysis Services detected the column that underlies the Calendar Quarter measure as a column that contains measures. However, this column
and the CalendarYear column contain the values that you will use to link the Sales Quotas measure group to the Date dimension later in this
topic.

13. In the Measures pane, right-click the Sales Quotas measure group, and then click New Measure. For more information, see Defining
Measures4.

The New Measure dialog box opens, containing the available source columns for a measure with a usage type of Sum.

14. In the New Measure dialog box, select Distinct count in the Usage list, verify that SalesQuotas is selected in the Source table list, select
EmployeeKey in the Source column list, and then click OK.

Notice that the measure is created in a new measure group named Sales Quotas 1. Distinct count measures in SQL Server are created in their
own measure groups to maximize processing performance.

15. Change the value for the Name property for the Employee Key Distinct Count measure to Sales Person Count, and then type #,# as the
value for the FormatString property.

To browse the measures in the Sales Quota measure group by date

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the
Reconnect button.
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Defining Dimension Usage Properties for the Sales Quotas Measure Group

3. Clear all hierarchies and measures from the Data pane, and then clear the dimension member from the Filter pane.

4. Expand the Sales Quotas measure group in the metadata pane, and then add the Sales Amount Quota measure to the data area.

5. Add the Sales Territories user-defined hierarchy in the Sales Territory dimension to the column area.

Notice that the Sales Territory cube dimension is not related, directly or indirectly, to the Fact Sales Quota table, as shown in the following
image.

In the next task in this topic you will define a reference dimension relationship between this dimension and this fact table.

6. In the Data pane, click the down arrow next to Sales Territory Group, and then clear all check boxes except for the check box for North
America, to change the dimension members that are displayed in Sales Territory Group to North America.

7. In the metadata pane, expand Date.

8. Add the Date.Fiscal Date user hierarchy to the row area, and then click the down arrow next to Fiscal Year in the Data pane and clear all
check boxes other than FY 2004, to display only fiscal year 2004.

9. In the Data pane, expand FY 2004, expand H1 FY 2004, expand Q1 FY 2004, and then expand July 2003.

Notice that only the July 2003 member of the Month level appears, instead of the July, 2003, August, 2003, and September, 2003 members
of Month level, and that only the July 1, 2003 member of the Date level appears, instead of all 31 days. This behavior occurs because the
grain of the data in the fact table is at the quarter level and the grain of the Date dimension is the daily level. You will change this behavior in
the next task in this topic.

Notice also that the Sales Amount Quota value for the month and day levels is the same value as for the quarter level, $13,733,000.00. This is
because the lowest level of data in the Sales Quotas measure group is at the quarter level. You will change this behavior in Lesson 6.

The following image shows the values for Sales Amount Quota.

To define dimension usage properties for the Sales Quotas measure group

1. Open Dimension Designer for the Employee dimension, right-click SalesTerritoryKey in the Data Source View pane, and then click New
Attribute from Column.

2. In the Attributes pane, select SalesTerritoryKey, and then set the AttributeHierarchyVisible property to False in the Properties window,
set the AttributeHierarchyOptimizedState property to NotOptimized, and set the AttributeHierarchyOrdered property to False.

This attribute is required to link the Sales Territory dimension to the Sales Quotas and Sales Quotas 1 measure groups as a referenced
dimension.

3. In Cube Designer for the Analysis Services Tutorial cube, click the Dimension Usage tab, and then review the dimension usage within the Sales
Quotas and Sales Quotas 1 measure groups.

Notice that the Employee and Date cube dimensions are linked to the Sales Quotas and Sales Quotas 1 measure groups through regular
relationships. Notice also that the Sales Territory cube dimension is not linked to either of these measure groups.

4. Click the cell at the intersection of the Sales Territory dimension and the Sales Quotas measure group and then click the browse button («).
The Define Relationship dialog box opens.

5. In the Select relationship type list, select Referenced.

6. In the Intermediate dimension list, select Employee.

7. In the Reference dimension attribute list, select Sales Territory Region.

8. In the Intermediate dimension attribute list, select Sales Territory Key. (The key column for the Sales Territory Region attribute is the
SalesTerritoryKey column.)

9. Verify that the Materialize check box is selected.

10. Click OK.

11. Click the cell at the intersection of the Sales Territory dimension and the Sales Quotas 1 measure group and then click the browse button
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Defining Attribute Relationships Between the Calendar Quarter Attribute and the Other Dimension Attribu
tes in the Date Dimension

Browsing the Measures in the Sales Quota Measure Group by Date

(«). The Define Relationship dialog box opens.

12. In the Select relationship type list, select Referenced.

13. In the Intermediate dimension list, select Employee.

14. In the Reference dimension attribute list, select Sales Territory Region.

15. In the Intermediate dimension attribute list, select Sales Territory Key. (The key column for the Sales Territory Region attribute is the
SalesTerritoryKey column.)

16. Verify that the Materialize check box is selected.

17. Click OK.

18. Delete the Date cube dimension.

Instead of having four time-related cube dimensions, you will use the Order Date cube dimension in the Sales Quotas measure group as the
date against which sales quotas will be dimensioned. You will also use this cube dimension as the primary date dimension in the cube.

19. In the Dimensions list, rename the Date (Order Date) cube dimension to Date (Date).

Renaming the Order Date cube dimension to Date makes it easier for users to understand its role as the primary date dimension in this cube.

20. Click the browse button («) in the cell at the intersection of the Sales Quotas measure group and the Date (Date) dimension.

21. In the Define Relationship dialog box, select Regular in the Select relationship type list.

22. In the Granularity attribute list, select Calendar Quarter.

Notice that a warning appears to notify you that because you have selected a non-key attribute as the granularity attribute, you must make
sure that all other attributes are directly or indirectly related to the granularity attribute by specifying them as member properties.

23. In the Relationship area of the Define Relationship dialog box, link the CalendarYear and CalendarQuarter dimension columns from the
table that underlies the Date (Date) cube dimension to the CalendarYear and CalendarQuarter columns in the table that underlies the Sales
Quota measure group, and then click OK.

The Calendar Quarter is defined as the granularity attribute for the Date (Date) cube dimension in the Sales Quotas measure group, but the
Date attribute continues to be the granularity attribute for the Internet Sales and Reseller Sales measure groups.

24. Repeat the previous four steps for the Sales Quotas 1 measure group.

To define attribute relationships between the Calendar Quarter attribute and the other d imension attributes in the Date d imension

1. Switch to Dimension Designer for the Date dimension, and then click the Attribute Relationships tab.

Notice that although Calendar Year is linked to Calendar Quarter through the Calendar Semester attribute, the fiscal calendar attributes are
linked only to one another; they are not linked to the Calendar Quarter attribute and therefore will not aggregate correctly in the Sales
Quotas measure group.

2. In the diagram, right-click the Calendar Quarter attribute and then select New Attribute Relationship.

3. In the Create Attribute Relationship dialog box, the Source Attribute is Calendar Quarter. Set the Related Attribute to Fiscal Quarter.

4. Click OK.

Notice that a warning message appears stating that the Date dimension contains one or more redundant attribute relationships that may
prevent data from being aggregated when a non-key attribute is used as a granularity attribute.

5. Delete the attribute relationship between the Month Name attribute and the Fiscal Quarter attribute.

6. On the File menu, click Save All.

To browse the measures in the Sales Quota measure group by date

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click
Reconnect.

Notice that the Sales Amount Quota measure is correctly dimensioned by Sales Territory because the Sales Territory dimension is now
defined as a referenced dimension.

3. Add the Date.FiscalDate user hierarchy to the row area from the Date cube dimension, and then click the down arrow next to Fiscal Year and
clear all check boxes other than FY 2004, to display only fiscal year 2004.

4. Click OK.

5. Expand FY 2004, expand H1 FY 2004, and then expand Q1 FY 2004.

Notice that the measures in the Sales Quotas measure group are correctly dimensioned. Notice also that each member of the fiscal quarter level
appears, with the value for each member being the value of the quarter level. This behavior occurs because the grain of the data in the fact
table is at the quarter level and the grain of the Date dimension is also at the quarter level. In Lesson 6, you will learn how to allocate the
quarterly amount proportionally to each month.

The following image shows Cube Designer for the Analysis Services Tutorial cube, with the Sales Quota measure group dimensioned correctly.
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Lesson 6: Defining Calculations
SQL Server 2008 R2
In this lesson, you learn to define calculations, which are Multidimensional Expressions (MDX) expressions or scripts. Calculations enable you to define
calculated members, named sets, and execute other script commands to extend the capabilities of an Analysis Services cube. For example, you can run
a script command to define a subcube and then assign a calculation to the cells in the subcube.

When you define a new calculation in Cube Designer, the calculation is added to the Script Organizer pane of the Calculations tab of Cube Designer,
and the fields for the particular calculation type are displayed in a calculations form in the Calculation Expressions pane. Calculations are executed in
the order in which they are listed in the Script Organizer pane. You can reorder the calculations by right-clicking on a particular calculation and then
selecting Move Up or Move Down, or by clicking a particular calculation and then using the Move Up or Move Down icons on the toolbar of the
Calculations tab.

On the Calculations tab, you can add new calculations and view or edit existing calculations in the following views in the Calculation Expressions
pane:

Form view. This view shows the expressions and properties for a single command in a graphical format. When you edit an MDX script, an expression
box fills the Form view.

Script view. This view displays all calculation scripts in a code editor, which lets you easily change the calculation scripts. When the Calculation
Expressions pane is in Script view, the Script Organizer is hidden. The Script view provides color coding, parenthesis matching, auto-complete,
and MDX code regions. You can expand or collapse the MDX code regions to make editing easier.

To switch between these views in the Calculation Expressions pane, click Form View or Script View on the toolbar of the Calculations tab.

If Analysis Services detects a syntax error in any calculation, the Form view will not display until the error is corrected in the Script view.

You can also use the Business Intelligence Wizard to add certain calculations to a cube. For example, you can use this wizard to add time intelligence to
a cube, which means defining calculated members for time-related calculations such as period-to-date, moving averages, or period over period growth.
For more information, see Defining Time Intelligence Calculations using the Business Intelligence Wizard1.

On the Calculations tab, the calculation script starts with the CALCULATE command. The CALCULATE command controls the aggregation of the cells
in the cube and you should edit this command only if you intend to manually specify how the cube cells should be aggregated.

For more information, see Calculations2, and Defining Calculations3.

A completed project through Lesson 5 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases4.

This lesson contains the following tasks:

Defining Calculated Members5

In this task, you learn to define calculated members.

Defining Named Sets6

In this task, you learn to define named sets.

Defining Scoped Assignments Using Script Commands7

In this task, you learn to use script commands to define subcubes and to assign calculations to the subcube space by using MDX calculations.

Lesson 7: Defining Key Performance Indicators (KPIs)8
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Defining Calculations to Aggregate Physical Measures

Defining Calculated Members
SQL Server 2008 R2
Calculated members are members of a dimension or a measure group that are defined based on a combination of cube data, arithmetic operators,
numbers, and functions. For example, you can create a calculated member that calculates the sum of two physical measures in the cube. Calculated
member definitions are stored in cubes, but their values are calculated at query time.

To create a calculated member, use the New Calculated Member command on the Calculations tab of Cube Designer. You can create a calculated
member within any dimension, including the measures dimension. You can also place a calculated member within a display folder in the Calculation
Properties dialog box. For more information, see Calculations1, Defining Calculations2, and Creating Calculated Members3.

In the tasks in this topic, you define calculated measures to let users view the gross profit margin percentage and sales ratios for Internet sales, reseller
sales, and for all sales.

To define calculations to aggregate physical measures

1. Open Cube Designer for the Analysis Services Tutorial cube, and then click the Calculations tab.

Notice the default CALCULATE command in the Calculation Expressions pane and in the Script Organizer pane. This command specifies that
the measures in the cube should be aggregated according to the value that is specified by their AggregateFunction properties. Measure values
are generally summed, but may also be counted or aggregated in some other manner.

The following image shows the Calculations tab of Cube Designer.

2. On the toolbar of the Calculations tab, click New Calculated Member.

A new form appears in the Calculation Expressions pane within which you define the properties of this new calculated member. The new
member also appears in the Script Organizer pane.

The following image shows the form that appears in the Calculation Expressions pane when you click New Calculated Member.

3. In the Name box, change the name of the calculated measure to [Total Sales Amount].

If the name of a calculated member contains a space, the calculated member name must be enclosed in square brackets.

http://technet.microsoft.com/en-us/default.aspx
http://technet.microsoft.com/en-us/library/ms174902(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms175362(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms174952(v=sql.105).aspx
javascript:void(0)


 Note

Notice in the Parent hierarchy list that, by default, a new calculated member is created in the Measures dimension. A calculated member in
the Measures dimension is also frequently called a calculated measure.

4. On the Metadata tab in the Calculation Tools pane of the Calculations tab, expand Measures and then expand Internet Sales to view the
metadata for the Internet Sales measure group.

You can drag metadata elements from the Calculation Tools pane into the Expression box and then add operators and other elements to
create Multidimensional Expressions (MDX) expressions. Alternatively, you can type the MDX expression directly into the Expression box.

If you cannot view any metadata in the Calculation Tools pane, click Reconnect on the toolbar. If this does not work, you may have to
process the cube or start the instance of Analysis Services.

5. Drag Internet Sales-Sales Amount from the Metadata tab in the Calculation Tools pane into the Expression box in the Calculation
Expressions pane.

6. In the Expression box, type a plus sign (+) after [Measures].[Internet Sales-Sales Amount].

7. On the Metadata tab in the Calculation Tools pane, expand Reseller Sales, and then drag Reseller Sales-Sales Amount into the
Expression box in the Calculation Expressions pane after the plus sign (+).

8. In the Format string list, select "Currency".

9. In the Non-empty behavior list, select the check boxes for Internet Sales-Sales Amount and Reseller Sales-Sales Amount, and then click
OK.

The measures you specify in the Non-empty behavior list are used to resolve NON EMPTY queries in MDX. When you specify one or more
measures in the Non-empty behavior list, Analysis Services treats the calculated member as empty if all the specified measures are empty. If
the Non-empty behavior property is blank, Analysis Services must evaluate the calculated member itself to determine whether the member is
empty.

The following image shows the Calculation Expressions pane populated with the settings that you specified in the previous steps.

10. On the toolbar of the Calculations tab, click Script View, and then review the calculation script in the Calculation Expressions pane.

Notice that the new calculation is added to the initial CALCULATE expression; each individual calculation is separated by a semicolon. Notice also
that a comment appears at the beginning of the calculation script. Adding comments within the calculation script for groups of calculations is a
good practice, to help you and other developers understand complex calculation scripts.

11. Add a new line in the calculation script after the Calculate; command and before the newly added calculation script, and then add the following
text to the script on its own line:

The following image shows the calculation scripts as they should appear in the Calculation Expressions pane at this point in the tutorial.

12. On the toolbar of the Calculations tab, click Form View, verify that [Total Sales Amount] is selected in the Script Organizer pane, and then
click New Calculated Member.

��������������������������������������������������������������������������



Defining Gross Profit Margin Calculations

13. Change the name of this new calculated member to [Total Product Cost], and then create the following expression in the Expression box:

14. In the Format string list, select "Currency".

15. In the Non-empty behavior list, select the check boxes for Internet Sales-Total Product Cost and Reseller Sales-Total Product Cost, and
then click OK.

You have now defined two calculated members, both of which are visible in the Script Organizer pane. These calculated members can be used
by other calculations that you define later in the calculation script. You can view the definition of any calculated member by selecting the
calculated member in the Script Organizer pane; the definition of the calculated member will appear in the Calculation Expressions pane in
the Form view. Newly defined calculated members will not appear in the Calculation Tools pane until these objects have been deployed.
Calculations do not require processing.

To define gross profit margin calculations

1. Verify that [Total Product Cost] is selected in the Script Organizer pane, and then click New Calculated Member on the toolbar of the
Calculations tab.

2. In the Name box, change the name of this new calculated measure to [Internet GPM].

3. In the Expression box, create the following MDX expression:

4. In the Format string list, select "Percent".

5. In the Non-empty behavior list, select the check box for Internet Sales-Sales Amount, and then click OK.

6. On the toolbar of the Calculations tab, click New Calculated Member.

7. In the Name box, change the name of this new calculated measure to [Reseller GPM].

8. In the Expression box, create the following MDX expression:

9. In the Format string list, select "Percent".

10. In the Non-empty behavior list, select the check box for Reseller Sales-Sales Amount, and then click OK.

11. On the toolbar of the Calculations tab, click New Calculated Member.

12. In the Name box, change the name of this calculated measure to [Total GPM].

13. In the Expression box, create the following MDX expression:

Notice that this calculated member is referencing other calculated members. Because this calculated member will be calculated after the
calculated members that it references, this is a valid calculated member.

14. In the Format string list, select "Percent".

15. In the Non-empty behavior list, select the check boxes for Internet Sales-Sales Amount and Reseller Sales-Sales Amount, and then click
OK.

16. On the toolbar of the Calculations tab, click Script View and review the three calculations you just added to the calculation script.

17. Add a new line in the calculation script immediately before the [Internet GPM] calculation, and then add the following text to the script on its
own line:

The following image shows the Expressions pane with the three new calculations.
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Defining the Percent of Total Calculations

Browsing the New Calculated Members

To define the percent of total calculations

1. On the toolbar of the Calculations tab, click Form View.

2. In the Script Organizer pane, select [Total GPM], and then click New Calculated Member on the toolbar of the Calculations tab.

Clicking the final calculated member in the Script Organizer pane before you click New Calculated Member guarantees that the new
calculated member will be entered at the end of the script. Scripts execute in the order that they appear in the Script Organizer pane.

3. Change the name of this new calculated member to [Internet Sales Ratio to All Products].

4. Type the following expression in the Expression box:

This MDX expression calculates the contribution to total Internet sales of each product. The Case statement together with the IS EMPTY
function ensures that a divide by zero error does not occur when a product has no sales.

5. In the Format string list, select "Percent".

6. In the Non-empty behavior list, select the check box for Internet Sales-Sales Amount, and then click OK.

7. On the toolbar of the Calculations tab, click New Calculated Member.

8. Change the name of this calculated member to [Reseller Sales Ratio to All Products].

9. Type the following expression in the Expression box:

10. In the Format string list, select "Percent".

11. In the Non-empty behavior list, select the check box for Reseller Sales-Sales Amount, and then click OK.

12. On the toolbar of the Calculations tab, click New Calculated Member.

13. Change the name of this calculated member to [Total Sales Ratio to All Products].

14. Type the following expression in the Expression box:

15. In the Format string list, select "Percent".

16. In the Non-empty behavior list, select the check boxes for Internet Sales-Sales Amount and Reseller Sales-Sales Amount, and then click
OK.

17. On the toolbar of the Calculations tab, click Script View, and then review the three calculations that you just added to the calculation script.

18. Add a new line in the calculation script immediately before the [Internet Sales Ratio to All Products] calculation, and then add the following
text to the script on its own line:

You have now defined a total of eight calculated members, which are visible in the Script Organizer pane when you are in Form view.

To browse the new calculated members
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Next Task in Lesson

See Also
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1. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to the Browser tab, click Reconnect, and then remove all hierarchies and measures from
the Data pane.

3. In the Metadata pane, expand Measures to view the new calculated members in the Measures dimension.

4. Add the Total Sales Amount, Internet Sales-Sales Amount, and Reseller Sales-Sales Amount measures to the data area, and then review
the results.

Notice that the Total Sales Amount measure is the sum of the Internet Sales-Sales Amount measure and the Reseller Sales-Sales Amount
measure.

5. Add the Product Categories user-defined hierarchy to the filter area of the Data pane, and then filter the data by Mountain Bikes.

Notice that the Total Sales Amount measure is calculated for the Mountain Bikes category of product sales based on the Internet Sales-
Sales Amount and the Reseller Sales-Sales Amount measures for Mountain Bikes.

6. Add the Date.Calendar Date user-defined hierarchy to the row area, and then review the results.

Notice that the Total Sales Amount measure for each calendar year is calculated for the Mountain Bikes category of product sales based on
the Internet Sales-Sales Amount and the Reseller Sales-Sales Amount measures for Mountain Bikes.

7. Add the Total GPM, Internet GPM, and Reseller GPM measures to the data area, and then review the results.

Notice that the gross profit margin for reseller sales is significantly lower than for sales over the Internet. Notice also that the gross profit margin
on the sales of mountain bikes is increasing over time, as shown in the following image.

8. Add the Total Sales Ratio to All Products, Internet Sales Ratio to All Products, and Reseller Sales Ratio to All Products measures to the
data area.

Notice that the ratio of the sales of mountain bikes to all products has increased over time for Internet sales, but is decreasing over time for
reseller sales. Notice also that the ratio of the sale of mountain bikes to all products is lower from sales through resellers than it is for sales over
the Internet.

9. Change the filter from Mountain Bikes to Bikes, and review the results.

Notice that the gross profit margin for all bikes sold through resellers is negative, because touring bikes and road bikes are being sold at a loss.

10. Change the filter to Accessories, and then review the results.

Notice that the sale of accessories is increasing over time, but that these sales make up only a small fraction of total sales. Notice also that the
gross profit margin for sales of accessories is higher than for bikes.

11. Expand CY 2004, expand H2 CY 2004, and then expand Q3 CY 2004.

Notice that there are no Internet sales in this cube for after July, 2004, and no reseller sales for after June, 2004. These sales values have not
yet been added from the source systems to the Adventure Works DW database.

Defining Named Sets4
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Defining a Core Products Named Set

Defining a Large Resellers Named Set

Defining Named Sets
SQL Server 2008 R2
A named set is a Multidimensional Expressions (MDX) expression that returns a set of dimension members. You can define named sets and save them as
part of the cube definition; you can also create named sets in client applications. You create named sets by combining cube data, arithmetic operators,
numbers, and functions. Named sets can be used by users in MDX queries in client applications and can also be used to define sets in subcubes. A
subcube is a collection of crossjoined sets that restricts the cube space to the defined subspace for subsequent statements. Defining a restricted cube
space is a fundamental concept to MDX scripting.

Named sets simplify MDX queries and provide useful aliases for complex, typically used, set expressions. For example, you can define a named set called
Large Resellers that contains the set of members in the Reseller dimension that have the most employees. End users could then use the Large Resellers
named set in queries, or you could use the named set to define a set in a subcube. Named set definitions are stored in cubes, but their values exist only
in memory. To create a named set, use the New Named Set command on the Calculations tab of Cube Designer. For more information, see
Calculations1, Creating Named Sets2.

In the tasks in this topic, you will define two named sets: a Core Products named set and a Large Resellers named set.

To define a Core Products named set

1. Switch to the Calculations tab of Cube Designer for the Analysis Services Tutorial cube, and then click Form View on the toolbar.

2. Click [Total Sales Ratio to All Products] in the Script Organizer pane, and then click New Named Set on the toolbar of the Calculations
tab.

When you define a new calculation on the Calculations tab, remember that calculations are resolved in the order in which they appear in the
Script Organizer pane. Your focus within that pane when you create a new calculation determines the order of the execution of the
calculation; a new calculation is defined immediately after the calculation on which you are focused.

3. In the Name box, change the name of the new named set to [Core Products].

In the Script Organizer pane, notice the unique icon that differentiates a named set from a script command or a calculated member.

4. On the Metadata tab in the Calculation Tools pane, expand Product, expand Category, expand Members, and then expand All Products.

If you cannot view any metadata in the Calculation Tools pane, click Reconnect on the toolbar. If this does not work, you may have to
process the cube or start the instance of Analysis Services.

5. Drag Bikes into the Expression box.

You now have created a set expression that will return the set of members that are in the Bike category in the Product dimension.

To define a Large Resellers named set

1. Right-click [Core Products] in the Script Organizer pane, and then click New Named Set.

2. In the Name box, change the name of this named set to [Large Resellers].

3. In the Expression box, type Exists().

You will use the Exists function to return the set of members from the Reseller Name attribute hierarchy that intersects with the set of members
in the Number of Employees attribute hierarchy that has the largest number of employees.

4. On the Metadata tab in the Calculation Tools pane, expand the Reseller dimension, and then expand the Reseller Name attribute hierarchy.

5. Drag the Reseller Name level into the parenthesis for the Exists set expression.

You will use the Members function to return all members of this set. Related topic: Members (Set) (MDX)3

6. After the partial set expression, type a period, and then add the Members function. Your expression should look like the following:

Now that you have defined the first set for the Exists�VHW�H[SUHVVLRQ��\RX�DUH�UHDG\�WR�DGG�WKH�VHFRQG�VHW²WKH�VHW�RI�PHPEHUV�RI�WKH�5HVHOOHU
dimension that contains the largest number of employees.

7. On the Metadata tab in the Calculation Tools pane, expand Number of Employees in the Reseller dimension, expand Members, and then
expand All Resellers.

Notice that the members of this attribute hierarchy are not grouped.

8. Open Dimension Designer for the Reseller dimension, and then click Number of Employees in the Attributes pane.

9. In the Properties window, change the DiscretizationMethod property to Automatic, and then change the DiscretizationBucketCount
property to 5. Related topic: Grouping Attribute Members (Discretization)4

10. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Services Tutorial.

11. When deployment has successfully completed, switch to Cube Designer for the Analysis Services Tutorial cube, and then click Reconnect on the
toolbar of the Calculations tab.

12. On the Metadata tab in the Calculation Tools pane, expand Number of Employees in the Reseller dimension, expand Members, and then
expand All Resellers.

Notice that the members of this attribute hierarchy are now contained in five groups, numbered 0 through 4. To view the number of a group,
pause the pointer over that group to view an InfoTip. The members of this attribute hierarchy are grouped because the
DiscretizationBucketCount property is set to 5 and the DiscretizationMethod property is set to Automatic.
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Browsing the Cube by Using the New Named Sets

13. In the Expression box, add a comma in the Exists set expression after the Members function and before the closing parenthesis, and then
drag 83 - 100 from the Metadata pane and position it after the comma.

You have now completed the Exists set expression that will return the set of members that intersects with these two specified sets, the set of
all resellers and the set of resellers who have 83 to 100 employees, when the Large Resellers named set is put on an axis.

The following image shows the Calculation Expressions pane for the [Large Resellers] named set.

14. On the toolbar of the Calculations tab, click Script View, and then review the two named sets that you have just added to the calculation
script.

15. Add a new line in the calculation script immediately before the first CREATE SET command, and then add the following text to the script on its
own line:

You have now defined two named sets, which are visible in the Script Organizer pane. You are now ready to deploy these named sets, and
then to browse these measures in the Analysis Services Tutorial cube.

To browse the cube by using the new named sets

1. On the Build menu of BI Development Studio, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab, and then click Reconnect.

3. Remove all hierarchies and measures from the Data pane.

4. Add the Reseller Sales-Sales Amount measure to the data area, and then add the Product Categories user-defined hierarchy to the row
area.

All members will appear if you are working in a new session. If only one member of the category attribute appears, this is because you previously
used this attribute as a filter in this session. To display all members, select the drop-down arrow next to Category in the Row area, select the
check box next to the (All) level to select all members of this level (if it is not already selected), and then click OK.

5. Expand Bikes to view the members of the Subcategory level, as shown in the following image.

6. In the Metadata pane, in the Product dimension, right-click Core Products, and select Add to Subcube Area.

Notice that only the Bike member of the Category attribute and members of the Bike subcategories remain in the cube. This is because the
Core Products named set is used to define a subcube, the properties of which appear in the Filter pane, which is the pane above the Data
pane. This subcube limits the members of the Category attribute in the Product dimension within the subcube to those members of the Core
Product named set, as shown in the following image.

7. In the Metadata pane, expand Reseller, right-click Large Resellers, and then select Add to Subcube Area.

Notice that the Reseller Sales Amount measure in the Data pane only displays sales amounts for large resellers of bikes. Notice also that the
Filter pane now displays the two named sets that are used to define this particular subcube, as shown in the following image.
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Defining Scoped Assignments Using Script Commands5
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Reviewing Sales Amount Quota Allocations by Date and Employee

Defining the Scope for the Sales Amount Quota Calculation for Fiscal Year 2005

Defining Scoped Assignments Using Script Commands
SQL Server 2008 R2
In Analysis Services, Multidimensional Expressions (MDX) scripts can apply to the whole cube, or to specific sections of the cube, at specific points within the
execution of the script. You have already learned about the default script command, the CALCULATE statement, which populates cells in the cube with aggregated
data based on the default scope.

The default scope is the whole cube, but as mentioned in the previous topic, you can use the SCOPE statement to define a more limited scope, known as a subcube,
and then apply an MDX script to only that particular cube space. The SCOPE statement defines the scope of all subsequent MDX expressions and statements within
the calculation script until the current scope ends or is rescoped. The THIS statement is then used to apply an MDX expression to the current scope. You can use the
BACK_COLOR statement to specify a background cell color for the cells in the current scope, to help you during debugging.

In the tasks in this topic, you will use the SCOPE and THIS statements to define sales quotas for each fiscal quarter within fiscal year 2005. You will then allocate
sales quotas to the month level for all fiscal years in the cube. You will also learn about how to use breakpoints to help you in debugging the calculation script.

To review the sales amount quota allocations by date and employee

1. Open Cube Designer for the Analysis Services Tutorial cube, and then click the Browser tab.

2. Remove all hierarchies and measures from the Data pane and remove all dimension members from the Filter pane.

3. Add the Sales Amount Quota measure from the Sales Quotas measure group to the data area of the Data pane.

4. Add the Fiscal Date user-defined hierarchy from the Date dimension to the column area.

5. Add the Employee Name attribute hierarchy from the Employee dimension to the row area.

Notice that no sales quota values have been defined for the 2005 fiscal year.

6. In the column area, click the arrow button beside Fiscal Year, clear the checkboxes beside FY 2002 and FY 2003 and then click OK.

7. In the column area, expand FY2004, expand H2 FY 2004, and then expand Q4 FY 2004.

Notice that the sales amount quota for each fiscal month in the fiscal quarter is the same amount as the sales amount quota for the fiscal quarter. This is
because the grain of the time dimension in the Sales Quota measure group is the quarter level, as discussed in Lesson 5.

The following image shows the sales quota for each employee who has a sales quota for each month in the fourth quarter of fiscal year 2004.

In this task, you will review the current scope, modify the scope, and then define a calculation that determines the sales amount quota values for the 2005 fiscal
year based on the values for the 2004 fiscal year.

To define the scope for the Sales Amount Quota calculation for fiscal year 2005

1. Select the Calculations tab, and then select Form View on the toolbar.

2. In the Script Organizer pane, select Large Resellers, and then click the New Script Command button on the toolbar of the Calculations tab.

Notice that an empty script appears in the Calculation Expressions pane and that this script command is displayed with a blank title in the Script Organizer
pane.

3. In the Calculation Expressions pane, type the following statement:

This SCOPE statement changes the cube scope to the All, or default, member for all attributes in the cube.

4. Click New Script Command on the toolbar of the Calculations tab, and then type the following statement in the Calculation Expressions pane:

Notice that a red squiggly line appears underneath the final parenthesis, to indicate that you have to define a set of members within the parentheses for the
SCOPE statement. Next, you will add the Sales Amount Quota measure to the SCOPE statement to include this measure within the scope.

5. On the Metadata tab in the Calculation Tools pane, expand Measures, expand Sales Quotas, and then drag the Sales Amount Quota measure into the
parentheses for the SCOPE statement in the Calculation Expressions pane.

Notice that the red squiggly line disappears. Next, you will add the FY 2005 dimension member to the SCOPE statement to add this time dimension member to
the current scope.

6. On the Metadata tab in the Calculation Tools pane, expand the Date dimension, expand Fiscal, expand Fiscal Date, expand Fiscal Year, and then drag the
FY 2005 member into the SCOPE statement in the Calculation Expressions pane immediately after the [Sales Amount Quota] member of the set that you
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Defining and Testing the New Sales Quota Calculation for Fiscal Year 2005

Allocating Sales Amount Quotas to Fiscal Year 2005 Semesters and Quarters

are defining.

Notice the red squiggly line under the [Date] part of this new member of this set. This line informs you that a syntax error exists immediately before this
dimension member, because a comma is required between each member of the set within the SCOPE statement.

7. Add the necessary comma before the [Date] part of the FY 2005 member of the Date dimension.

Notice that the initial red squiggly line disappears. Next, you will add the members of the Employees user-defined hierarchy in the Employee dimension to the
SCOPE statement to add these members to the current scope.

8. On the Metadata tab in the Calculation Tools pane, expand the Employee dimension, and then drag the Employees user-defined hierarchy into the SCOPE
statement in the Calculation Expressions pane immediately after the [Date].[Fiscal Date].[Fiscal Year].&[2005] member of the set that you are defining.

Notice the red squiggly line under the [Employee] part of this new member of this set, to indicate that a comma is required between each member of the set
within the SCOPE statement.

9. Add the necessary comma before the [Employee] part of the new member.

Notice that the red squiggly line has disappeared.

10. At the end of the [Employee].[Employees] member of this set within the SCOPE statement, add the following clause to complete the definition of this third
member of the set:

This clause specifies that all members of the Employees hierarchy within the Employee dimension should be included in the current cube scope.

11. Verify that your completed SCOPE statement matches the following script:

You have now completed your scope definition that defines the subcube to which you will apply an MDX expression to calculate the sales quota amount for
Fiscal Year 2005.

12. On the toolbar of the Calculations tab, click Script View, and then review the newly added script commands.

Notice that each script command appears as you typed it in the Calculation Expressions pane, but with a semicolon added to the end of each script
command. Also, notice that Analysis Services has inserted a comment before each script command to help you understand each separate command.

In this task, you will add a new script command to the calculation script that calculates the sales quota amount for Fiscal Year 2005 for all members of the
Employee dimension. However, instead of adding the script command in the Form view, you will add the script command directly in the Script view. In the Script
view, you must make sure to add a semicolon between each script command.

To define and test the new Sales Quota calculation for fiscal year 2005

1. In the Script view, type the following statements on a new line at the end of the calculation script:

The THIS statement allocates a new value to the Sales Amount Quota measure at the intersection of the Employee member and the FY 2005 member of
the subcube. The new value is based on the value that exists for the intersection of the Employee member and the Sales Amount Quota measure in Fiscal
Year 2004 multiplied by 1.25.

2. In the Calculation Expressions pane, click in the margin to the left of the THIS statement to set a breakpoint.

Notice that a red dot appears in that margin and that the statement is highlighted in red. When you execute this project in debug mode, the changes to your
project are deployed to your instance of Analysis Services, the cube is processed, and the calculation script executes until the breakpoint is encountered. You
can then step through the remaining scripts one by one. If you do not set a breakpoint and run the project in debug mode, the calculation script will break at
the first script statement, the CALCULATE statement.

3. On the Debug menu, click Start Debugging. Alternatively,you can press F5 on your keyboard.

The project is deployed and processed, and the calculation script executes until the breakpoint is encountered.

4. Hide all docked windows to provide more area to view the Pivot Table pane that appears at the bottom of the Calculations tab.

The Pivot Table pane will help you with debugging.

5. In the Pivot Table pane, add the Sales Amount Quota measure to the data area, add the Fiscal Date user-defined hierarchy to the column area, and then
add the Employee Name attribute hierarchy from the Employee dimension to the row area. Scroll down to the bottom of the pivot table and review the
employees who have sales quotas assigned to them.

Notice that the FY 2005 member of the Fiscal Year level for the Sales Amount Quota measure for each employee contains no value in the data area for the
Sales Amount Quota measure. By default, empty cells are displayed in the Pivot Table pane when you are in debug mode.

6. Press F10 to execute the THIS statement and calculate the sales quota for fiscal year 2005.

Notice that the cells in the Pivot Table pane at the intersection of the Sales Amount Quota measure, the FY 2005 dimension member, and the Employee
Name member are now calculated. Notice also that the cells affected by the THIS statement are highlighted in yellow. There is a toolbar icon to enable or
disable the highlighting of changed cells. By default, changed cells are highlighted.

7. In the Pivot Table pane, clear the check boxes to remove FY 2002, FY 2003, and FY 2004 from the column area.

8. Right-click anywhere in the data area and then click Show Empty Cells to remove the check mark next to this option and hide all empty cells (this option is
also available on the Calculations tab toolbar). This will make it easier to view all the employees who have sales amount quota values.

9. In the Pivot Table pane, try to expand FY 2005 in the column area.

Notice that you cannot expand FY 2005 because the values for the H1 FY 2005 member at the intersection of the Sales Amount Quota measure and the
Employee Name attribute hierarchy was not calculated (because they were outside the current scope).

10. To view the empty cells for the values for H1 FY 2005 members, click anywhere in the Pivot Table pane and then click Show Empty Cells on the
Calculations tab toolbar to show all empty cells.

11. On the Debug menu, click Stop Debugging or press Shift-F5 on your keyboard.

12. Remove the breakpoint in the calculation script by clicking the red dot in the left margin.

In this task, you modify the scope to include the fiscal semester members of Fiscal Year 2005 instead of the Fiscal Year 2005 member, and then allocate one-half of
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the sales amount quota value for Fiscal Year 2005 to each semester in Fiscal Year 2005. You then modify the scope to include the fiscal quarter members of Fiscal
Year 2005 instead of the Fiscal Year 2005 member, and then allocate one-fourth of the sales amount quota value for Fiscal Year 2005 to each quarter in Fiscal Year
2005. To complete the task, you then test these allocations.

To allocate sales amount quotas to Fiscal Year 2005 Semesters and Quarters

1. In the Script view of the Calculation Expressions pane, type the following statement on a new line at the end of the calculation script:

This SCOPE statement is a nested SCOPE statement, because no END SCOPE statement appears between this SCOPE statement and the previous SCOPE
statement. When a SCOPE statement is nested, the nested SCOPE statement inherits the parent scope for those attributes that are not rescoped. The
previous SCOPE statement does not directly modify the Sales Amount Quota measure, the Employees user-defined hierarchy, or the Fiscal Date user-
defined hierarchy. Instead, it adds each member of the Fiscal Semester attribute hierarchy to the subcube definition by using the Members function. For
more information, see Members (Set) (MDX)1. As a result of the nested SCOPE statement, the cube space now includes all members that are at the
intersection of the Employee member and the Sales Amount Quota measure in any fiscal semester in Fiscal Year 2005. Note that there is currently only one
fiscal semester in Fiscal Year 2005 in the cube.

2. In the Calculation Expressions pane, type the following statement on a new line at the end of the calculation script:

This statement allocates to each fiscal semester in the defined cube space the calculated value for the fiscal quarter. The CurrentMember.Parent function is
used to allocate to each member half of the value of its parent. For more information, see CurrentMember (MDX)2, and Parent (MDX)3.

3. In the Calculation Expressions pane, type the following statement on a new line at the end of the calculation script:

This SCOPE statement is also a nested SCOPE statement, because no END SCOPE statement appears between this SCOPE statement and the previous
SCOPE statement. The previous SCOPE statement does not directly modify the Sales Amount Quota measure, the Employees user-defined hierarchy, or
the Fiscal Date user-defined hierarchy. Instead, it adds each member of the Fiscal Quarter attribute hierarchy to the subcube definition by using the
Members function. As a result, the cube space now includes all members that are at the intersection of the Employee member and the Sales Amount
Quota measure in any fiscal quarter in fiscal year 2005. Note that there is currently only one fiscal quarter in Fiscal Year 2005 in the cube.

4. In the Calculation Expressions pane, type the following statement on a new line at the end of the calculation script:

This statement allocates to each fiscal quarter in the defined cube space the calculated value for the fiscal quarter. The CurrentMember.Parent function is
used to allocate to each member one-half of the value of its parent.

5. In the Calculation Expressions pane, click in the margin next to the final SCOPE statement to set a breakpoint, and then press F5 on your keyboard.

The calculation script executes until the breakpoint is encountered.

6. Click anywhere in the data area of the Pivot Table pane and then click Show Empty Cells on the Calculation tab toolbar to hide empty cells.

Notice that the data pane is populated with the same measures and hierarchies that you used on the last pass through the debugger, and that the value for
the H1 FY 2005 member has been calculated, one-half of its parent's value, as shown in the image later.

Finally, notice that the value for each FY 2005 member is recalculated based on the aggregation of its members, which in this case is the first fiscal semester
of the fiscal year. The value of the Fiscal Year 2005 member is affected by the calculation for the Fiscal Semester 2005 member because each script executes
as a separate pass. To pin an existing value so that it is not affected by subsequent statements in the calculation script, use the FREEZE statement. For more
information, see FREEZE Statement (MDX)4.

7. In the column area, expand H1 FY 2005.

Notice that the value for the Q1 FY 2005 member has not yet been calculated.

8. Click anywhere in the data area of the Pivot Table pane and then click Show Empty Cells on the Calculation tab toolbar.

9. In the column area, expand Q1 FY 2005.

Notice that no value is allocated to the two months in the first quarter of Fiscal Year 2005 because these members are not yet within the scope of the current
subcube (until the final two statements in the script are executed). The time dimension in the Analysis Services Tutorial cube only contains the first two
months of Fiscal Year 2005. Therefore, there are no Q2 FY 2005 members.

10. Press F10 to execute the SCOPE statement and then press F10 again to execute final statement in the calculation script, which applies the calculation to the
current subcube.

�������������������������������������������������������������������
��������������������������������������������������������������

�����������������������������������������������������

������������������������������������������������������������������
������������������������������������������������������������

�����������������������������������������������������

http://technet.microsoft.com/en-us/library/ms144851(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms144948(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms145513(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms144733(v=sql.105).aspx


Note

Allocating Sales Quotas to M onths

Notice that the value for the Q1 FY 2005 member is calculated, and the value of the H1 FY 2005 and the FY2005 member values are re-calculated (as the
aggregate of their child members), as shown in the following image. Notice also that the value for each fiscal month in Fiscal Year 2005 (July and August of
2005) is not calculated. In the next procedure, you will allocate appropriate values to each quarter.

11. On the Debugging menu, click Stop Debugging or press Shift-F5 on your keyboard.

12. Remove the breakpoint in the calculation script.

In this procedure, you will modify the scope to include the fiscal month level in all fiscal years (the previous scope statements limited the calculations to fiscal year
2005 only). You will then allocate one-third of the fiscal quarter value for the sales amount quota for each employee to each fiscal month.

To allocate sales quotas to months

1. In the Calculation Expressions pane, add the following statements on a new line at the end of the calculation script:

This SCOPE statement is another nested scope statement that modifies the cube space to which you will apply an MDX expression to allocate sales amount
quotas to each fiscal month based on the value for each fiscal quarter. This SCOPE statement is like the previous nested SCOPE statement, but notice that
the Fiscal Date user-defined hierarchy itself is rescoped. Therefore, the members of the cube space will now include all fiscal month members of the Date
dimension, instead of just the fiscal month members of Fiscal Year 2005.

Compare this modification of the cube scope with the modification of the cube scope in the previous procedure to make sure that you understand the
difference between the two scope change statements.

2. In the Calculation Expressions pane, add the following statements on a new line at the end of the calculation script:

7KLV�VWDWHPHQW�DOORFDWHV�WR�HDFK�PRQWK�PHPEHU�RI�WKH�ILVFDO�GDWH�KLHUDUFK\�RQH�WKLUG�RI�WKH�YDOXH�RI�LWV�SDUHQW²WKH�TXDUWHU�OHYHO��7KLV�FDOFXODWLRQ�ZLOO�DSSO\�WR
all fiscal months within the cube.

3. In the Calculation Expressions pane, click in the margin to the left of the final THIS statement to set a breakpoint, and then press F5 on your keyboard.

4. Review the values for July 2004 and August 2004.

Notice that no value is currently calculated for either July 2004 or August 2004.

5. Right-click anywhere in the Data pane, and then click Show Empty Cells to display only cells that have values.

This will let you more easily see how the final statement is applied in the calculation script.

6. Press F10 to execute the final statement.

Notice that the Sales Amount Quota value for each employee for each fiscal month is calculated to a value that is equal to one-third of its parent value.

7. In the column area, remove FY 2005 and then add Q4 FY 2004.

8. Expand FY 2004, expand H2 FY 2004, and then expand Q4 FY 2004.

Notice that the value for each fiscal month is equal to the total value for the fiscal quarter.

9. On the Debug menu, click Stop Debugging.

10. Remove the breakpoint in the calculation script.

11. On the toolbar, click Save All.
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Lesson 7: Defining Key Performance Indicators (KPIs)
SQL Server 2008 R2
In this lesson, you learn to define Key Performance Indicators (KPIs) in your Analysis Services project. KPIs provide a framework for defining server-side
calculations that measure your business, and they standardize how the resulting information is displayed. KPIs can be displayed in reports, portals, and
dashboards, through data access APIs, and through Microsoft tools and third-party tools. KPIs are metadata wrappers around regular measures and
other Multidimensional Expressions (MDX) expressions. For more information, see Key Performance Indicators (KPIs)1.

A completed project through Lesson 6 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases2.

This lesson contains the following task:

Defining and Browsing KPIs3

In this task, you define KPIs in the Form view and then switch to the Browser view to browse the cube data by using the KPIs.

Lesson 8: Defining Actions4
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Note

Defining the Reseller Revenue KPI

Defining and Browsing KPIs
SQL Server 2008 R2
To define key performance indicators (KPIs), you first define a KPI name and the measure group to which the KPI is associated. A KPI can be associated
with all measure groups or with a single measure group. You then define the following elements of the KPI:

The value expression

A value expression is a physical measure such as Sales, a calculated measure such as Profit, or a calculation that is defined within the KPI by using
a Multidimensional Expressions (MDX) expression.

The goal expression

A goal expression is a value, or an MDX expression that resolves to a value, that defines the target for the measure that the value expression
defines. For example, a goal expression could be the amount by which the business managers of a company want to increase sales or profit.

The status expression

A status expression is an MDX expression that Analysis Services uses to evaluate the current status of the value expression compared to the goal
expression. A goal expression is a normalized value in the range of -1 to +1, where -1 is very bad, and +1 is very good. The status expression
displays a graphic to help you easily determine the status of the value expression compared to the goal expression.

The trend expression

A trend expression is an MDX expression that Analysis Services uses to evaluate the current trend of the value expression compared to the goal
expression. The trend expression helps the business user to quickly determine whether the value expression is becoming better or worse relative to
the goal expression. You can associate one of several graphics with the trend expression to help business users be able to quickly understand the
trend.

In addition to these elements that you define for a KPI, you also define several properties of a KPI. These properties include a display folder, a parent KPI
if the KPI is computed from other KPIs, the current time member if there is one, the weight of the KPI if it has one, and a description of the KPI.

For more examples of KPIs, see the KPI examples on the Templates tab in the Calculation Tools pane or in the examples in the Adventure Works DW
sample data warehouse. For more information, see Adventure Works Sample Data Warehouse1.

In the task in this lesson, you define KPIs in the Analysis Services Tutorial project, and you then browse the Analysis Services Tutorial cube by using
these KPIs. You will define the following KPIs:

Reseller Revenue

This KPI is used to measure how actual reseller sales compare to sales quotas for reseller sales, how close the sales are to the goal, and what the
trend is toward reaching the goal.

Product Gross Profit Margin

This KPI is used to determine how close the gross profit margin is for each product category to a specified goal for each product category, and
also to determine the trend toward reaching this goal.

To define the Reseller Revenue KPI

1. Open Cube Designer for the Analysis Services Tutorial cube, and then click the KPIs tab.

The KPIs tab includes several panes. On the left side of the tab are the KPI Organizer pane and the Calculation Tools pane. The display pane
in the middle of the tab contains the details of the KPI that is selected in the KPI Organizer pane.

The following image shows the KPIs tab of Cube Designer.
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2. On the toolbar of the KPIs tab, click the New KPI button.

A blank KPI template appears in the display pane, as shown in the following image.

3. In the Name box, type Reseller Revenue, and then select Reseller Sales in the Associated measure group list.

4. On the Metadata tab in the Calculation Tools pane, expand Measures, expand Reseller Sales, and then drag the Reseller Sales-Sales
Amount measure to the Value Expression box.

5. On the Metadata tab in the Calculation Tools pane, expand Measures, expand Sales Quotas, and then drag the Sales Amount Quota
measure to the Goal Expression box.

6. Verify that Gauge is selected in the Status indicator list, and then type the following MDX expression in the Status expression box:

This MDX expression provides the basis for evaluating the progress toward the goal. In this MDX expression, if actual reseller sales are more than
85 percent of the goal, a value of 0 is used to populate the chosen graphic. Because a gauge is the chosen graphic, the pointer in the gauge will
be half-way between empty and full. If actual reseller sales are more the 90 percent, the pointer on the gauge will be three-fourths of the way
between empty and full.

7. Verify that Standard arrow is selected in the Trend indicator list, and then type the following expression in the Trend expression box:
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Browsing the Cube by Using the Reseller Revenue KPI

Defining the Product Gross Profit Margin KPI

This MDX expression provides the basis for evaluating the trend toward achieving the defined goal.

To browse the cube by using the Reseller Revenue KPI

1. On the Build menu of Business Intelligence Development Studio, click Deploy Analysis Service Tutorial.

2. When deployment has successfully completed, on the toolbar of the KPIs tab, click the Browser View button , and then click Reconnect.

The status and trend gauges are displayed in the KPI Browser pane for reseller sales based on the values for the default member of each
dimension, together with the value for the value and the goal. The default member of each dimension is the All member of the All level, because
you have not defined any other member of any dimension as the default member.

3. In the filter pane, select Sales Territory in the Dimension list, select Sales Territories in the Hierarchy list, select Equal in the Operator
list, select the North America check box in the Filter Expression list, and then click OK.

4. In the next row in the Filter pane, select Date in the Dimension list, select Calendar Date in the Hierarchy list, select Equal in the
Operator list, select the Q3 CY 2003 check box in the Filter Expression list, and then click OK.

5. Click anywhere in the KPI Browser pane to update the values for the Reseller Revenue KPI.

Notice that the Value, Goal, and Status sections of the KPI reflect the values for the new time period

To define the Total Gross Profit Marg in KPI

1. Click the Form View button on the toolbar of the KPIs tab, and then click the New KPI button.

2. In the Name box, type Product Gross Profit Margin, and then verify that <All> appears in the Associated measure group list.

3. In the Metadata tab in the Calculation Tools pane, drag the Total GPM measure to the Value Expression box.

4. In the Goal Expression box, type the following expression:

5. In the Status indicator list, select Cylinder.

6. Type the following MDX expression in the Status expression box:

This MDX expression provides the basis for evaluating the progress toward the goal.

7. Verify that Standard arrow is selected in the Trend indicator list, and then type the following MDX expression in the Trend expression box:
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This MDX expression provides the basis for evaluating the trend toward achieving the defined goal.

To browse the cube by using the Total Gross Profit Marg in KPI

1. On the Build menu, click Deploy Analysis Service Tutorial.

2. When deployment has successfully completed, click Reconnect on the toolbar of the KPIs tab, and then click Browser View.

The Product Gross Profit Margin KPI appears and displays the KPI value for Q3 CY 2003 and the North America sales territory.

3. In the Filter pane, select Product in the Dimension list, select Category in the Hierarchy list, select Equal in the Operator list, and then
select Bikes in the Filter Expression list, and then click OK.

The gross profit margin for the sale of Bikes by resellers in North America in Q3 CY 2003 appears.
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Lesson 8: Defining Actions
SQL Server 2008 R2
In this lesson, you will learn to define actions in your Analysis Services project. An action is just a Multidimensional Expressions (MDX) statement that is
stored in Analysis Services and which can be incorporated into client applications and started by a user.

A completed project through Lesson 7 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases1.

Analysis Services supports the types of actions that are described in the following table.

CommandLine Executes a command at the command prompt

Dataset Returns a dataset to a client application.

Drillthrough Returns a drillthrough statement as an expression, which the client executes to return a rowset

Html Executes an HTML script in an Internet browser

Proprietary Performs an operation by using an interface other than those listed in this table.

Report Submits a parameterized URL-based request to a report server and returns a report to a client application.

Rowset Returns a rowset to a client application.

Statement Runs an OLE DB command.

URL Displays a dynamic Web page in an Internet browser.

Actions let users start an application or perform other steps within the context of a selected item. For more information, see Actions (Analysis Services -
Multidimensional Data)2, Defining and Configuring Actions (Analysis Services - Multidimensional Data)3

For examples of actions, see the action examples on the Templates tab in the Calculation Tools pane or in the examples in the Adventure Works DW
sample data warehouse. For more information, see Adventure Works Sample Data Warehouse4.

This lesson includes the following task:

Defining and Using a Drillthrough Action5

In this task, you define, use, and then modify a drillthrough action through the fact dimension relationship that you defined earlier in this tutorial.
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Defining the Drillthrough Action Properties

Defining and Using a Drillthrough Action
SQL Server 2008 R2
Dimensioning fact data by a fact dimension without correctly filtering the data that the query returns can cause slow query performance. To avoid this,
you can define a drillthrough action that restricts the total number of rows that are returned. This will significantly improve query performance.

In the tasks in this topic, you define a drillthrough action to return order detail information for sales to customers over the Internet.

To define the drillthrough action properties

1. In Cube Designer for the Analysis Services Tutorial cube, click the Actions tab.

The Actions tab includes several panes. On the left side of the tab are the Action Organizer pane and the Calculation Tools pane. The pane
to the right of these two panes is the Display pane, which contains the details of the action that is selected in the Action Organizer pane.

The following image shows the Actions tab of Cube Designer.

2. On the toolbar of the Actions tab, click the New Drillthrough Action button.

A blank action template appears in the display pane.

3. In the Name box, change the name of this action to Internet Sales Details Drillthrough Action.

4. In the Measure group members list, select Internet Sales.

http://technet.microsoft.com/en-us/default.aspx
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Using the Drillthrough Action

5. In the Drillthrough Columns box, select Internet Sales Order Details in the Dimensions list.

6. In the Return Columns list, select the Item Description and the Order Number check boxes, and then click OK. The following image shows
the Action template as it should appear at this point in this procedure.

7. Expand the Additional Properties box, as shown in the following image.

8. In the Maximum Rows box, type 10.

9. In the Caption box, type 'ULOOWKURXJK�WR�2UGHU�'HWDLOV«.

These settings limit the number of rows returned and specify the caption that appears in the client application menu. The following image shows
these settings in the Additional Properties box.

To use the drillthrough action

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, click the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then click the
Reconnect button.

3. Remove all hierarchies and measures from the Data pane and all dimension members from the Filter pane.

4. Add the Internet Sales-Sales Amount measure to the data area.

5. Add the Customer Geography user-defined hierarchy from the Location folder in the Customer dimension to the Filter pane.

6. In the Filter Expression list, expand All Customers, expand Australia, expand Queensland, expand Brisbane, expand 4000, select the
check box for Adam Powell, and then click OK.

The total sales of products by Adventure Works Cycles to Adam Powell are displayed in the data area.
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M odifying the Drillthrough Action

Reviewing the M odified Drillthrough Action

7. Click the data cell in the Data pane, and then right-click that data cell and click Drillthrough to Order Details.

The details of the orders that were shipped to Adam Powell are displayed in the Data Sample Viewer, as shown in the following image.
However, some additional details would also be useful, such as the order date, due date, and ship date. In the next procedure, you will add
these additional details.

8. Click Close to close the Data Sample Viewer window.

To modify the drillthrough action

1. Open Dimension Designer for the Internet Sales Order Details dimension.

Notice that only three attributes have been defined for this dimension.

2. In the Data Source View pane, right-click an open area, and then click Show All Tables.

3. On the Format menu, point to Autolayout and then click Diagram.

4. Locate the InternetSales (dbo.FactInternetSales) table by right-clicking in an open area of the Data Source View pane. Then click Find
Table, click InternetSales, and click OK.

5. Create new attributes based on the following columns:

OrderDateKey

DueDateKey

ShipDateKey

6. Change the Name property for the Order Date Key attribute to Order Date Then, click the browse button for the Name Column property,
and in the Name Column dialog box, select Date as the source table and select SimpleDate as the source column. Click OK.

7. Change the Name property for the Due Date Key attribute to Due Date, and then, by using the same method as the Order Date Key
attribute, change the Name Column property for this attribute to Date.SimpleDate (WChar).

8. Change the Name property for the Ship Date Key attribute to Ship Date, and then change the Name Column property for this attribute to
Date.SimpleDate (WChar).

9. Switch to the Actions tab of Cube Designer for the Analysis Services Tutorial cube.

10. In the Drillthrough Columns box, select the check boxes to add the following columns to the Return Columns list, and then click OK:

Order Date

Due Date

Ship Date

The following image shows these columns selected.

To review the modified drillthrough action

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to the Browser tab in Cube Designer for the Analysis Services Tutorial cube, and then
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click the Reconnect button.

3. Click the single data cell, and then right-click that cell and click Drillthrough to Order Details.

The details of these orders shipped to Adam Powell are displayed in the Data Sample Viewer. This includes the order date, due date, and ship
date information, as shown in the following image.

4. Click Close to close the Data Sample Viewer.
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Lesson 9: Defining Perspectives and Translations
SQL Server 2008 R2
In this lesson, you learn to define perspectives and translations. You can define perspectives to reduce the apparent complexity of a cube, and define
translations that let users view the cube metadata in the language of their choice.

A completed project through Lesson 8 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases1.

This lesson contains the following tasks:

Defining and Browsing Perspectives2

In this task, you define and browse perspectives to simplify the view of the cube for specific users or uses.

Defining and Browsing Translations3

In this task, you define and browse translations of specific metadata to certain languages.
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Defining an Internet Sales Perspective

Defining and Browsing Perspectives
SQL Server 2008 R2
A perspective can simplify the view of a cube for specific purposes. By default, users can see all of the elements in a cube to which they have
permissions. What users are viewing when they view an entire Analysis Services cube is the default perspective for the cube. A view of the whole cube
can be very complex for users to navigate, especially for users who only need to interact with a small part of the cube to satisfy their business
intelligence and reporting requirements.

To reduce the apparent complexity of a cube, you can create viewable subsets of the cube, called perspectives, which show users only a part of the
measure groups, measures, dimensions, attributes, hierarchies, Key Performance Indicators (KPIs), actions, and calculated members in the cube. This can
be particularly useful for working with client applications that were written for a previous release of Analysis Services. These clients have no concept of
display folders or perspectives, for example, but a perspective appears to older clients as if it were a cube. For more information, see Perspectives1, and
Defining Perspectives2.

A perspective is not a security mechanism, but instead is a tool for providing a better user experience. All security for a perspective is inherited from
the underlying cube.

In the tasks in this topic, you will define several different perspectives and then browse the cube through each of these new perspectives.

To define an Internet Sales perspective

1. Open Cube Designer for the Analysis Services Tutorial cube, and then click the Perspectives tab.

All the objects and their object types appear in the Perspectives pane, as shown in the following image.

2. On the toolbar of the Perspectives tab, click the New Perspective button.

A new perspective appears in the Perspective Name column with a default name of Perspective, as shown in the following image. Notice that
the check box for every object is selected; until you clear the check box for an object, this perspective is identical to the default perspective of
this cube.
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 Note

Defining a Reseller Sales Perspective

3. Change the perspective name to Internet Sales.

4. On the next row, set the DefaultMeasure to Internet Sales-Sales Amount.

When users browse the cube by using this perspective, this will be the measure that the users see unless they specify some other measure.

You can also set the default measure for the whole Analysis Services Tutorial cube in the Properties window on the Cube Structure tab for
the cube.

5. Clear the check box for the following objects:

Reseller Sales measure group

Sales Quotas measure group

Sales Quotas 1 measure group

Reseller cube dimension

Reseller Geography cube dimension

Sales Territory cube dimension

Employee cube dimension

Promotion cube dimension

Reseller Revenue KPI

Large Resellers named set

Total Sales Amount calculated member

Total Product Cost calculated member

Reseller GPM calculated member

Total GPM calculated member

Reseller Sales Ratio to All Products calculated member

Total Sales Ratio to All Products calculated member

These objects do not relate to Internet sales.

Within each dimension, you can also individually select the user-defined hierarchies and attributes that you want to appear in a perspective.

To define a Reseller Sales perspective

1. On the toolbar of the Perspectives tab, click the New Perspective button.

2. Change the name of the new perspective to Reseller Sales.

3. Set Reseller Sales-Sales Amount as the default measure.

When users browse the cube by using this perspective, this measure will be the measure that the users will see unless they specify some other
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Defining a Sales Summary Perspective

Browsing the Cube Through Each Perspective

measure.

4. Clear the check box for the following objects:

Internet Sales measure group

Internet Sales Reason measure group

Customer cube dimension

Internet Sales Order Details cube dimension

Sales Reason cube dimension

Internet Sales Details Drillthrough Action drillthrough action

Total Sales Amount calculated member

Total Product Cost calculated member

Internet GPM calculated member

Total GPM calculated member

Internet Sales Ratio to All Products calculated member

Total Sales Ratio to All Products calculated member

These objects do not relate to resellers sales.

To define a Sales Summary perspective

1. On the toolbar of the Perspectives tab, click the New Perspective button.

2. Change the name of the new perspective to Sales Summary.

You cannot specify a calculated measure as the default measure.

3. Clear the check box for the following objects:

Internet Sales measure group

Reseller Sales measure group

Internet Sales Reason measure group

Sales Quotas measure group

Sales Quotas1 measure group

Internet Sales Order Details cube dimension

Sales Reason cube dimension

Internet Sales Details Drillthrough Action drillthrough action

4. Select the check box for the following objects:

Internet Sales Count measure

Reseller Sales Count measure

To browse the cube through each perspective

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to the Browser tab, and then click the Reconnect button.

3. Clear all measures and hierarchies from the data pane and all dimensions from the filter pane.

4. Review the measures and dimensions in the metadata pane.

Notice that all the defined measures and measure groups appear.

5. On the toolbar of the Browser tab, select Internet Sales in the Perspective list and then review the measures and dimensions in the
metadata pane.

Notice that only those objects that are specified for the Internet Sales perspective appear, as shown in the following image.
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6. In the metadata pane, expand Measures.

Notice that only the Internet Sales measure group appears, together with the Internet GPM and Internet Sales Ratio to All Products
calculated members.

7. Expand Internet Sales, right-click Internet Sales-Sales Amount, and then select Add to Data Area.

This measure appears in the Data pane.

8. In the Perspective list of the toolbar of the Browser tab, select Reseller Sales.

Notice that the Internet Sales-Sales Amount measure no longer appears in the Data pane.

9. In the metadata pane, expand Measures.

Notice that the Internet Sales measure group no longer appears in the measures list.

10. In the Perspectives list on the toolbar of the Browser tab, select Sales Summary.

11. In the metadata pane, expand Measures, expand Internet Sales and expand Reseller Sales.

Notice that in each of these measure groups, only a single measure appears, as shown in the following image.

Defining and Browsing Translations3

Concepts

Perspectives1

Defining Perspectives2

Links Table

1http://technet.microsoft.com/en-us/library/ms175338(v=sql.105).aspx

2http://technet.microsoft.com/en-us/library/ms174843(v=sql.105).aspx

3http://technet.microsoft.com/en-us/library/ms166708(v=sql.105).aspx

javascript:void(0)
http://technet.microsoft.com/en-us/library/ms166708(v=sql.105).aspx
javascript:void(0)
http://technet.microsoft.com/en-us/library/ms175338(v=sql.105).aspx
http://technet.microsoft.com/en-us/library/ms174843(v=sql.105).aspx
http://technet.microsoft.com/en-us/cc300389
http://www.microsoft.com/library/toolbar/3.0/trademarks/en-us.mspx
http://www.microsoft.com/info/privacy.mspx
http://social.msdn.microsoft.com/Forums/en-US/libraryfeedback/threads


Specifying Translations for the Date Dimension Metadata

Defining and Browsing Translations
SQL Server 2008 R2
A translation is a representation of the names of Analysis Services objects in a specific language. Objects include measure groups, measures, dimensions,
attributes, hierarchies, KPIs, actions, and calculated members. Translations provide server support for client applications that can support multiple
languages. By using such a client, the client passes the locale identifier (LCID) to the instance of Analysis Services, which uses the LCID to determine
which set of translations to use when it provides metadata for Analysis Services objects. If an Analysis Services object does not contain a translation for
that language, or does not contain a translation for a specified object, the default language is used in returning the object metadata back to the client.
For example, if a business user in France accesses a cube from a workstation that has a French locale setting, the business user will see the member
captions and member property values in French if a French translation exists. However, if a business user in Germany accesses the same cube from a
workstation that has a German locale setting, the business user will see the captions names and member property values in German. For more
information, see Dimension Translations1, Cube Translations2, Translations (Analysis Services - Multidimensional Data)3.

In the tasks in this topic, you define metadata translations for a limited set of dimension objects in the Date dimension and cube objects in the Analysis
Services Tutorial cube. You will then browse these dimension and cube objects to examine the metadata translations.

To specify translations for the Date dimension metadata

1. Open Dimension Designer for the Date dimension, and then click the Translations tab.

The metadata in the default language for each dimension object appears. The default language in the Analysis Services Tutorial cube is English.

2. On the toolbar of the Translations tab, click the New Translation button.

A list of languages appears in the Select Language dialog box.

3. Click Spanish (Spain), and then click OK.

A new column appears in which you will define the Spanish translations for the metadata objects you want to translate. In this tutorial, we will
only translate a few objects just to illustrate the process.

4. On the toolbar of the Translations tab, click the New Translation button, click French (France) in the Select Language dialog box, and then
click OK.

Another language column appears in which you will define French translations.

5. In the row for the Caption object for the Date dimension, type Fecha in the Spanish (Spain) translation column and Temps in the French
(France) translation column.

6. In the row for the Caption object for the Month Name attribute, type 0HV�GHO�$xR in the Spanish (Spain) translation column and Mois
G
$QQpH in the French (France) translation column.

Notice that when you enter these translations, an ellipsis («) appears. Clicking this ellipsis will enable you to specify a column in the underlying
table that provides translations for each member of the attribute hierarchy.

7. Click the ellipsis («) for the Spanish (Spain) translation for the Month Name attribute.

The Attribute Data Translation dialog box appears.

8. In the Translation columns list, select SpanishMonthName, as shown in the following image.

9. Click OK, and then click the ellipsis («) for the French (France) translation for the Month Name attribute.

10. In the Translation columns list, select FrenchMonthName, and then click OK.

The steps in this procedure illustrate the process of defining metadata translations for dimension objects and members.
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To specify translations for the Analysis Services Tutorial Cube metadata

1. Switch to Cube Designer for the Analysis Services Tutorial cube, and then switch to the Translations tab.

The metadata in the default language for each cube object appears, as shown in the following image. The default language in the Analysis
Services Tutorial cube is English.

2. On the toolbar of the Translations tab, click the New Translation button.

A list of languages appears in the Select Language dialog box.

3. Select Spanish (Spain), and then click OK.

A new column appears in which you will define the Spanish translations for the metadata objects you want to translate. In this tutorial, we will
only translate a few objects just to illustrate the process.

4. On the toolbar of the Translations tab, click the New Translation button, select French (France) in the Select Language dialog box, and
then click OK.

Another language column appears in which you will define French translations.

5. In the row for the Caption object for the Internet Sales measure group, type Ventas del lnternet in the Spanish (Spain) translation column
and Ventes D'Internet in the French (France) translation column.

6. In the row for the Caption object for the Internet Sales-Sales Amount measure, type Cantidad de las Ventas del Internet in the Spanish
(Spain) translation column and 4XDQWLWp�GH�9HQWHV�G
,QWHUQHW in the French (France) translation column.

The steps in this procedure illustrate the process of defining metadata translations for cube objects.

To browse the cube by using translations

1. On the Build menu, click Deploy Analysis Services Tutorial.

2. When deployment has successfully completed, switch to the Browser tab, and then click Reconnect.

3. Remove all hierarchies and measures from the Data pane and select Analysis Services Tutorial in the Perspectives list.

4. In the metadata pane, expand Measures and then expand Internet Sales.

Notice that the Internet Sales-Sales Amount measure appears in English in this measure group.

5. On the toolbar, select Spanish (Spain) in the Language list.

Notice that the items in the metadata pane are repopulated. After the items in the metadata pane are repopulated, notice that the Internet
Sales-Sales Amount measure no longer appears in the Internet Sales display folder. Instead, it appears in Spanish in a new display folder named
Ventas del lnternet, as shown in the following image.
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6. In the metadata pane, right-click Cantidad de las Ventas del Internet and then select Add to Data Area.

7. In the metadata pane, expand Fecha, expand Calendar, right-click Fecha.Calendar Date, and then select Add to Row Area.

8. In the Data pane, expand CY 2004, expand H1 CY 2004, and then expand Q1 CY 2004.

Notice that the month names appear in Spanish, as shown in the following image.

9. On the toolbar, select French (France) in the Language list.

Notice that the month names now appear in French and that the measure name now also appears in French.
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Lesson 10: Defining Administrative Roles
SQL Server 2008 R2
In this lesson, you learn to define security roles for administrative tasks.

A completed project through Lesson 9 is available by downloading and installing the samples. For more information, see Considerations for Installing
SQL Server Samples and Sample Databases1.

This lesson contains the following task:

Granting Process Database Permissions2

In this task, you define a security role that has permissions to process the Analysis Services database, and then you test this security role. For
more information, see Granting Administrative Permissions Within a Database3.
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After you install an instance of Analysis Services, all members of the Administrators local group are members of the Analysis Services Server role in that
instance and have server-wide permissions to perform any task within the instance of Analysis Services. By default, no other users have any permission
to administer or view any objects in the instance of Analysis Services.

A member of the Analysis Services Server role can grant users administrative access on a server-wide basis by making them members of the Server role,
which grants them unrestricted access to all Analysis Services objects and data in that instance. A member of the Analysis Services Server role can
grant users access on a more limited basis by granting them limited or complete administrative or access permissions at the database level. Limited
administrative permissions include process or read definition permissions at the database, cube, or dimension level.

In the tasks in this topic, you will define a Process Database Objects security role that grants members of the role permission to process all database
objects, but no permission to view data within the database.

To define a Process Database Objects security role

1. In Solution Explorer, right-click Roles and then click New Role.

Role Designer appears, as shown in the following image.

2. Click the Process database check box.

3. In the Properties window, change the Name property for this new role to Process Database Objects Role.

4. Switch to the Membership tab of Role Designer.

Notice that there are no users or groups in this role. You are just creating a role in this procedure. After deployment, an administrator can add
users or groups to the role.

5. Switch to the Cubes tab of Role Designer.

Notice that members of this role have permissions to process this database, but have no permission to access the data in the Analysis Services
Tutorial cube and have no local cube/drillthrough access, as shown in the following image.
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6. Switch to the Dimensions tab of Role Designer.

Notice that members of this role have permissions to process all dimension objects in this database, and, by default, have read permissions to
access each dimension object in the Analysis Services Tutorial database.

7. On the Build menu, click Deploy Analysis Services Tutorial.

You have now successfully defined and deployed the Process Database Objects security role. After a cube is deployed to the production
environment, the administrators of the deployed cube can add users to this role as required to delegate processing responsibilities to specific
users.

A completed project for Lesson 10 is available by downloading and installing the samples. For more information, see Considerations for Installing SQL
Server Samples and Sample Databases1.
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